FBV™ MkII Series Controller
Advanced User Guide

Using the FBV Shortboard™ MkII or FBV Express™ MkII with Line 6 POD® X3, POD Farm™ 2, GearBox™ & 3rd Party Software
## Table of Contents

### Getting Started

FBV MkII with Line 6 Spider® Amplifiers ................................................................. 1.1
Updating & Registering with Line 6 Monkey .......................................................... 1.1
Line 6 FBV™ Control Application Installation ......................................................... 1.3
Connecting FBV MkII to your POD® X3 ................................................................. 1.5
Connecting FBV MkII to Your Computer ............................................................... 1.5
FBV Pedal Calibration ......................................................................................... 1.7
Expression Pedal ............................................................................................... 1.8

### FBV™ MkII with POD® X3

Quick Start ........................................................................................................ 2.1
Calling Up User Presets ..................................................................................... 2.1
Controlling Effects & More .............................................................................. 2.3
POD X3 System Configuration - Pedal Settings .................................................. 2.4
Using FBV Pedals with Tone 1 and Tone 2 .......................................................... 2.7
Controlling Dual Tone Presets .......................................................................... 2.9

### The Line 6 FBV Control Application

What’s in it for Me? .......................................................................................... 3.1
Graphical User Interface .................................................................................. 3.1
Footswitch Control Behaviors ........................................................................ 3.5
Footswitch LED Behaviors ............................................................................. 3.6
Pedal Control Behaviors ................................................................................. 3.7
Opening and Saving FBV Presets .................................................................. 3.7
Preferences ..................................................................................................... 3.9
The ‘About Line 6 FBV Control Application’ Dialog ........................................ 3.10
The FBV Shortboard MkII LCD Display ............................................................ 3.10

### FBV™ MkII with Line 6 POD Farm™ 2

What is POD Farm 2? ....................................................................................... 4.1
About USB MIDI Ports & Channels ................................................................. 4.1
POD Farm 2 Pre-configured MIDI Assignments ............................................... 4.3
“POD Farm 2” FBV MkII Control Presets ................................................................. 4•3
POD Farm 2 Standalone Application - MIDI Input Configuration ................... 4•7
POD Farm 2 Plug-In - MIDI Input Configuration ............................................... 4•8
The POD Farm 2 MIDI Assignments View ....................................................... 4•10
MIDI Learn in POD Farm 2 ............................................................................. 4•10

FBV™ MkII with Line 6 GearBox™ ................................................................. 5•1

What is GearBox? ......................................................................................... 5•1
Get Connected .............................................................................................. 5•1
Customize Your GearBox Control ............................................................... 5•4

FBV™ MkII with 3rd Party Software ............................................................. 6•1

About USB MIDI Ports & Channels ............................................................... 6•1
MIDI Learn Functionality ............................................................................. 6•3
Manual MIDI Control Assignment ............................................................... 6•3
Ableton Live® - FBV MkII Setup Tutorial .................................................... 6•4
Apple GarageBand® - FBV MkII Setup Tutorial ........................................... 6•13
Apple Logic® - FBV MkII Setup Tutorial ...................................................... 6•14
Cakewalk SONAR™ - FBV MkII Setup Tutorial ............................................ 6•18
Propellerhead Reason® - FBV MkII Setup Tutorial ......................................... 6•22
Digidesign Pro Tools® LE Transport Control - FBV MkII Setup Tutorial ...... 6•25
Steinberg Cubase® - FBV MkII Setup Tutorial .............................................. 6•28

Reference ...................................................................................................... 7•1

Questions & Answers .................................................................................. 7•1
Troubleshooting ............................................................................................ 7•2
Online Resources ........................................................................................... 7•4
Congratulations if you’ve obtained a new FBV Shortboard™ MkII or FBV Express™ MkII since you are now equipped for remote, hands-free access to numerous Line 6 products, as well as 3rd party MIDI software! This document will walk you through setting up and using your FBV™ MkII Series Controller specifically with POD® X3, POD® X3 Pro, Line 6 POD Farm™ 2 & GearBox™ software, and 3rd party MIDI & DAW software that responds to MIDI control.

To get the most out of POD X3, POD Farm 2, or MIDI/DAW software, and best understand just what those FBV buttons and pedals are accessing, it is recommended you first read through the very helpful info in these products’ User Manuals. Another handy resource is the FBV MkII Series Controller User Manual, which comes in the box with your FBV MkII unit. Or, you can download all current documentation free from the Line 6 Support site at http://line6.com/support/manuals/.

FBV MkII with Line 6 Spider® Amplifiers

Line 6 FBV MkII Series Controllers are designed to work with many Line 6 Amplifiers. In particular, the Line 6 Spider® IV and Spider Valve™ MkII Amplifiers offer remote control of many exciting features such as Quick Loop, user preset navigation, effects parameter manipulation and more! Using FBV MkII Controllers with these amps is covered in the Spider® IV and Spider Valve™ MkII Advanced Guides, available for download free from the Line 6 Support site at http://line6.com/support/manuals/.

Updating & Registering with Line 6 Monkey

OK, so maybe you already read about doing this updating & registration stuff for your FBV MkII and other Line 6 products, but in case you were too excited with your new gear to get to that yet, now is the time to do it! It’s a simple process really, just run Line 6 Monkey™ on your computer with an Internet connection. Line 6 Monkey is the intelligent updater software utility that is typically installed with other Line 6 software titles. If you don’t already have it installed, you can get free from the Line 6 site at www.line6.com/monkey/.

Once you’ve installed the Line 6 Monkey software, connect your FBV MkII to your computer’s USB port (and please disconnect any other Line 6 USB devices for now since we only want Line 6 Monkey to check your FBV). Be sure to exit the Line 6 FBV Control application as well as any MIDI/DAW applications that might be running. With your computer’s Internet connection active, follow these steps to launch Line 6 Monkey.

- On Mac®, go to Applications > Line 6 > Line 6 Monkey
- On Windows®, go to the Start button menu > Programs > Line 6 > Tools > Line 6 Monkey

Login Account

You’ll need to Login so that Line 6 Monkey can communicate with the online Line 6 Server to provide the specific product updates for your gear. It’s just a few clicks, and it’s free!
If you have a Line 6 account, type in your User Name and Password at the top of the Monkey dialog.

If you have not yet created an account, click the New User button and you’ll be walked right through the steps.

**Register Your FBV**

Registration of your Line 6 gear may be required for some updates and product authorizations. It is also important because it ensures that you’re dialed in for warranty service and makes it possible for us to contact you if new software versions or other cool enhancements are offered - cutting edge technology and such!

If you have not already done so, you’ll be prompted to register your connected FBV MkII device. Just click that Register button and fill in the blanks on the web page. This page will list all your registered Line 6 gear in one place.

**Grab those Updates**

Once Line 6 Monkey launches, it will automatically detect your connected FBV MkII device. Within the Updates screen in Line 6 Monkey, if you see any items indicated with an exclamation symbol ⚠ then you should select the item in the list, click on the Update Selection button, and let the little Monkey fellow walk you through the installation steps. Items in the Updates screen indicated with a green check ✔, are up-to-date and need no attention. If you plan on connecting your FBV to your computer, then you’ll definitely want to have Monkey grab the Line 6 FBV Control application for you here too (more on this application in the next section).

Note that the columns on the right tell you the version numbers for all currently installed items and available updates. Click on any item in the Updates list and refer to its description in the Help and Info pane below. Also, at the left you’ll see your connected FBV device shown, along with its unique ESN (Electronic Serial Number), should you ever need to reference this ID number for registration or warranty service.

Running Line 6 Monkey is the easiest way to stay current on the latest Line 6 software and hardware updates!
Flash Memory Update

If Monkey tells you there is a newer Flash Memory version available for your FBV, then it is important that you install it for the best performance and product compatibility. Just follow the steps as Monkey instructs, including these important tasks:

- Exit any Line 6 software or 3rd party MIDI/DAW applications that might be using your FBV MkII device.
- Be sure not to press the buttons, move the pedal, or change any cable connections on your FBV device until the update process completes.
- Once Line 6 Monkey tells you the update was successfully completed, exit Line 6 Monkey and launch it again to see if any additional updates might still be available.

Line 6 FBV™ Control Application Installation

If you plan on using your FBV MkII to control software on your Mac® or Windows® computer, then you’ll also want to install the latest Line 6 FBV Control application. This free software provides you with the ability to create, load, edit and store FBV presets - full sets of customized MIDI controller configurations - all in an easy-to-use application!

Note: We’ll cover obtaining and installing the Line 6 FBV Control application here in this section. Please see “The Line 6 FBV Control Application” on page 3•1 for details on using the software!
System Requirements

We recommend that you read the separate, Line 6 FBV Control Release Notes for the full, detailed System Requirements, as well as current info on compatibility with other hardware and software. This document can be found within the Line 6 Support Community, or on the FBV MkII Online Help page.

Line 6 FBV Control supports the following computer operating systems:

- Windows® XP Home or Professional, with Service Pack 3, 32 and 64 bit versions
- Windows Vista® Home, Business or Ultimate Edition, with Service Pack 2, 32 and 64 bit versions
- Windows® 7 Home, Professional or Ultimate Edition, 32 and 64 bit versions
- Mac OS® X 10.4 (Tiger®)
- Mac OS® X 10.5 (Leopard®)
- Mac OS® X 10.6 (Snow Leopard®)

Note to Windows® 7 & Windows Vista® users: It is not recommended that you exit Windows® using the “Sleep” mode while you have the Line 6 FBV Control application running, or with your FBV connected to your USB port. Due to the inherent behavior of the USB Class Compliant driver, some USB devices (such as FBV) will not properly initialize when resuming from Sleep mode.

If you already have the Line 6 Monkey software utility installed on your computer

Connect your Line 6 FBV MkII device to your Mac® or Windows® computer's USB port and launch Line 6 Monkey. This will scan your system and point you to the latest Line 6 FBV Control installer available for you (see previous section). Select the Line 6 FBV Control application within Line 6 Monkey and it will walk you through downloading the software and launching the installer. Simply follow the steps in the installer.

If you do not have the Line 6 Monkey software utility installed on your computer

You can get the latest Line 6 FBV Control application installer for free by going to www.line6.com/software/. Be sure to choose your specific FBV MkII device from the Product selector, “Line 6 FBV Control” from the Software selector, and the specific Mac® or Windows® operating system version your computer uses from the OS selector. Once downloaded, just run the installer, following the steps along the way.

The Line 6 FBV Control installer will also install the latest Line 6 Monkey version - it is not necessary for you to download these items separately. Note that there is no special USB device driver software needed to be installed for your FBV MkII hardware - just connect the USB cable to your Mac® or Windows® computer and your operating system will automatically detect it as a new USB MIDI device.

Line 6 Software Compatibility

POD Farm 2 standalone application and POD Farm 2 Plug-In both offer extensive MIDI control capabilities, and your FBV MkII is the perfect USB MIDI controller device to use with them (see “FBV™ MkII with Line 6 POD Farm™ 2” on page 4•1). The earlier POD Farm™ 1.10 version does not provide support for external MIDI control. If you want to use your FBV MkII hardware to control the Line 6 GearBox software, you'll want to install the GearBox 3.7 version (or later) for best performance (see “FBV™ MkII with Line 6 GearBox™” on page 5•1). To get the latest GearBox version, connect your
Line 6 USB audio device you'll be using with GearBox (TonePort™, POD Studio™ or GuitarPort™ hardware) and launch Line 6 Monkey, or go directly to the Line 6 Software Downloads page and choose "GearBox" to access the latest installer.

To Uninstall Line 6 FBV Control

Should you ever need to uninstall the application, just follow these steps:

- **Mac®** - Open the Finder and browse to the Applications > Line 6 directory. Just drag the Line 6 FBV Control application to your Trash to remove it.
- **Windows®** - Go to Start > Programs > Line 6 > Tools and select the Line 6 Uninstaller utility. This handy application walks you through removing several Line 6 applications and device drivers. You'll have the option to choose to Line 6 FBV Control in the process.

Connecting FBV MkII to your POD® X3

Connecting your FBV Shortboard MkII or FBV Express MkII to a POD X3 or POD X3 Pro device is accomplished with one simple cable connection.

- First, power OFF your POD X3.
  
  Your FBV unit comes with a long cable that has “RJ-45” connectors on each end. Note that this cable is indeed a standard “Category 5” computer network cable. So, in case you lost yours, or your drummer dropped his cymbal on it, you can simply run down to any electronics or computer store and ask for a cable of this type.

- Plug one end of this cable into the **TO AMP** jack on the back of the FBV unit, and the other end into the **FBV PEDAL** jack on your POD X3.

- Power on your POD X3.

Power is supplied to your FBV MkII unit via this same cable connection. You should now see the FBV display show a patch name and/or indicator lights illuminated.

Note: You do not want to connect a USB cable to your FBV MkII device when using the RJ-45 cable connection described above, since doing so places FBV in “USB Mode” to communicate with a computer. You can, however, connect POD X3 to your computer via USB cable (from your POD X3 to your computer’s USB 2.0 port) if you want to use POD X3 as your USB audio device, or with the Line 6 GearBox software, while simultaneously controlling POD X3 with your FBV!

Connecting FBV MkII to Your Computer

To utilize your FBV Shortboard MkII or FBV Express MkII to control your software, simply connect a standard computer USB cable from the FBV unit’s USB jack to any USB 1.1 or 2.0 port on your Mac® or Windows® computer. Power is supplied to your FBV MkII unit via this same USB cable connection. You should see the FBV's LCD display or LED lights illuminate to show it is powered up.

The first time you connect your FBV Shortboard/Express MkII device to your computer’s USB port, your Mac® or Windows® operating system needs to install a device driver to allow your FBV to work with other hardware and software on your computer. On a Mac®, Windows® 7 or Windows Vista® computer, this process is done automatically, and you can skip to the next section to put your FBV to use.
On Windows® XP, you may need to click through a few dialogs to install the device driver. Once you connect the USB cable, you should see Windows® XP detect the new device at the bottom right of your screen:

Next, the Windows® Hardware Wizard will launch. Select “No, not this time” then click Next.

In the following screen, select the “Install automatically” option and click Next.

Note that XP recognizes and installs FBV as a “USB Audio Device”. This is normal behavior for the Windows® XP USB Class Compliant Driver.

Next you should see the final dialog telling the installation is complete - click Finish. Your FBV is now ready to rock!
FBV Pedal Calibration

Note: The following calibration steps are not necessary if your FBV MkII device has the 1.00 Flash Memory version. However, any Flash Memory update past version 1.00 will require that you calibrate your FBV pedal for the best performance. To check your FBV MkII current Flash Memory version, or to download & install any newer Flash Memory version that might be available, please use Line 6 Monkey, following the Update instructions on page 1•2.

For the best performance of the on-board pedal of your FBV Shortboard or Express MkII device, it is recommended that you perform the following steps to “calibrate” the pedal before putting it to use with your computer or your Line 6 Amp or POD.

FBV Shortboard MkII Calibration Steps

- Start with your FBV device not connected to any USB port or Line 6 device (and, therefore, powered “off”).
- Press and hold down the “D” labeled footswitch while you “power on” your FBV (by connecting to your computer’s USB port or Line 6 device with which you plan on using your FBV). The LCD will read “CALIBRATE PEDAL” until the D footswitch is released, at which point it will read “1 PEDAL TOE”.
- Press the on-board pedal forward fully and hold down pedal's Toe Switch until the LCD changes to “2 PEDAL MIN”. This should occur instantly.
- Move the pedal to the “heel” (minimum) position. While holding the pedal in the heel position, press & release the D button. The LCD will change to “3 PEDAL MAX”.
- Move the pedal to the toe (maximum) position, without clicking the Toe Switch. Allow the pedal to rest in the toe position and press & release the D button. The LCD will change to “CHECK VALUE 127”.
- Move the internal pedal and verify that the LCD reads “CHECK VALUE 0” in the minimum position and “CHECK VALUE 127” in the maximum position.
- If you happen to get different values that “0” or “127”, then try repeating these calibration steps. If your values are correct, then calibration was successful - power off your FBV and power it back on and you are ready to go!
FBV Express MkII Calibration Steps

- Start with your FBV device not connected to any USB port or Line 6 device (and, therefore, powered “off”).
- Press and hold down the “D” labeled footswitch while you “power on” your FBV (by connecting to your computer’s USB port, or Line 6 device with which you plan on using your FBV). Upon release of the D footswitch, the FBV Tuner’s numerical display will read “1”.
- Press the on-board pedal forward fully and hold down pedal’s Toe Switch until the Tuner display changes to “2”. This should occur instantly.
- While holding the pedal in the “heel” (minimum) position, press & release the D footswitch. The Tuner display will change to “3”.
- Move the pedal to the toe (maximum) position, without clicking the Toe Switch. Allow the pedal to rest in the toe position (maximum) and press & release the D button. The 7 LEDs above the Tuner’s numerical display will light.
- Move the pedal and verify that the LEDs above the Tuner’s numerical display sequentially turn off as the pedal moves to the minimum position, and all sequentially light up when the pedal is moved to the maximum position.
- If your 7 LEDs do not light up as described, then try repeating these calibration steps. If your LEDs light up correctly, then calibration was successful - power off your FBV and power it back on and you are ready to go!

Expression Pedal

FBV Shortboard MkII owners can optionally add a 2nd pedal for even greater control! The Line 6 EX-1 Expression Pedal is designed to work with the FBV Shortboard MkII plugging it into the Expression Pedal jack on the back of the chassis. The EX-1 can be purchased directly on the Line 6 Online Store, or from most Line 6 dealers.

Note: An Expression pedal does not require any calibration steps.

With the above steps complete you should now be ready to dive into the following chapters with your Line 6 FBV™ MkII Series Controller! Please see the following chapter that covers the specific gear you want to control with your FBV.
FBV™ MkII with POD® X3

In this chapter, we'll cover the specific features for using Line 6 FBV Shortboard™ MkII or FBV Express™ MkII to control POD® X3 “Bean” or POD® X3 Pro devices. Instructions are the same for POD X3 “Bean” and X3 Pro, unless otherwise noted. You should already have your FBV MkII connected and working with your POD X3. If not, then head on back to “Getting Started” on page 1.1 for instructions. Here we go!

Quick Start

OK, we know you're too impatient to read through this entire chapter before giving things a test drive! As you likely already figured out, things pretty much work right out of the box with your FBV MkII and POD X3, so here are a few quick tips:

• A, B, C, D Channel Buttons: Select to call up one of the four “Channels” in the current Bank within your POD X3 User folder.
• FBV Shortboard MkII: Press the “Bank” buttons (labeled with the up and down arrows) to scroll through the User Banks, then press A - D to recall the desired preset within the selected User Bank.
• FBV Express MkII: Turn the knob on your POD labeled “Press to Save” to scroll through your User Banks and you’ll see that these A - D Channel buttons let you select a preset within the current User Bank.
• Pedal: Typically controls either the Wah or Volume of the current preset - press the pedal forward to activate the toe switch to toggle between Wah or Volume.
• Tap: Tap in a tempo for your active Delay or Modulation effects of the current preset to follow.
• Effects Footswitches (Shortboard only): Press to toggle the labeled effect on/off in the current preset.
• Function 1 & 2 Footswitches (Shortboard only): By default, these toggle the Comp effect and Amp on/off, respectively, within the current preset.

Ready to dive deeper? Many more options and tips & tricks await you below!

Calling Up User Presets

This is likely what you'll be using your FBV MkII controller for most often - freeing up your hands and recalling those presets you so painstakingly created! It's all pretty straight-forward here. Your FBV provides you direct access to presets stored in the POD X3 User folder. You can see that when you stomp on your FBV to call up a preset that this automatically switches to the User folder, regardless of whether the previously loaded preset is one stored in this User folder or not.

FBV Shortboard™ MkII

BANK UP/DOWN: Step on Bank Up or Down to ‘cue’ the next User Bank and Channel. For example, if you currently have preset 1B loaded, press Bank Up and the FBV display flashes the selected Tone’s name for preset 2B so you know what's there, but it hasn’t audibly switched you out of 1B yet.

LOAD CHANNEL: Press the Channel A, B, C, or D button to instantly load the respective preset in the current User Bank. After pressing the Bank Up or Down button, the display will be flashing, waiting for you to select a Channel - As in the above example, pressing A will load preset 2A, or pressing B will load 2B, etc.
FBV Express™ MkII

LOAD CHANNEL: Press the A, B, C, or D button to instantly load the respective preset in the current User Bank. To select one of the 1 - 32 numbered Banks within your POD X3 User folder, turn the knob on your POD labeled “Press to Save”.

The POD X3 Home Page

The POD X3 Home page is your main screen where you can see the elements of the current preset. When POD X3 is set to the User folder you can press the HOME button to toggle between the “Tone Path” display and the alternate “Big User” display. This Big User display shows the Tone name(s) and makes it easy to see the preset’s Bank/Channel number from a distance, which can be very helpful when using your FBV/POD X3 in a live situation - or when wearing those cheap sunglasses of yours:

![POD X3 Home Page - Tone Path display and alternate Big User display]

The User Preset Folder

As you’ve probably discovered, POD X3 includes a total of over 350 presets and all are stored nice and neatly into “folders”. You can navigate through these folders on the POD X3 Home page by turning the corresponding multi-function knob:

![Turn to choose a folder.]

In the User folder are 128 User locations that you can use to store your own custom presets. If you step on one of the FBV Channel (A, B, C, D) buttons, you’ll see that this automatically switches POD X3 to the User folder, calling up the preset of the current Bank. The big idea here for configuring your FBV/POD X3 rig is that you create your own tone presets exactly how you like and then store them in the 128 memory locations within the User folder. These User presets are then accessible from your FBV.

You can see that we already gave you a head start and created some presets in the lower numbered Channel locations of the User folder - You can of course modify these as you like. You can also manually choose another folder on the POD X3 unit and use its on-board knobs to run through the
other presets.* You can modify these as well, and then when you push the SAVE button, choose one of the 128 locations in the User folder to store your customized preset there to allow it to be accessed your via your FBV.

*If you have an FBV Shortboard MkII model, note that its LCD display will always show the POD X3 current preset title, even if that preset is within a folder other than the User folder. The FBV effect switches and pedals will then control this current Tone, but the Bank and A, B, C, D buttons will always switch the POD X3 back to the User folder automatically to call up one of the 128 User presets.

Controlling Effects & More

Your FBV will also let you dive deeper into the workings of your POD X3 and do things like tune up, wangle some effects and more.

Note: A POD X3 preset can optionally be composed of two Tones, each with its own set of effects and effects parameter settings. Just like accessing the effects blocks and parameters directly on the POD X3 itself, using the following footswitch buttons will control only those effects for the currently selected Tone. To toggle between Tone 1 and Tone 2, use the TONE 2 button on the POD X3, or Shortboard users can configure the FUNCTION 1 button for Tone switching. See "Controlling Dual Tone Presets" on page 2•9.

FBV Shortboard™ MkII

FUNCTION 1: By default, this button toggles the COMP effect on/off. But you can alternatively configure it to control the Amp+Cab on/off, Tone 1/2 toggle, or FX Loop on/off (for X3 Pro units only).

TIP: The POD X3 System screen includes an “LP SW” (Loop Switch) setting for each Tone 1 and Tone 2 that allow you to select which of these actions is triggered by the FBV Shortboard FUNCTION 1 switch. This setting is configurable for each User preset - see "POD X3 System Configuration - Pedal Settings" on page 2•4.

FUNCTION 2: Toggles the AMP+CAB block on/off.

STOMP: Toggles the STOMP block on/off.

MODULATION: Toggles the MOD block on/off.

DELAY: Toggles the DLY block on/off.

REVERB: Toggles the VERB block on/off.

TAP: Allows you to tap in a tempo for supported Delay and Mod effects to follow. The LED above the button flashes to indicate the current tempo.

TUNER: Press and hold the TAP button down for 2 seconds to call up the Tuner. The FBV display then shows you a handy Tuner screen. Press & release the button again to exit the Tuner.

TIP: You can also set the “AUDIO” behavior for the Tuner mode on the POD X3 directly on the POD X3 Tuner page to either MUTE your audible signal or not. (Sure, everyone likes to hear a guitar in tune, but they don’t necessarily want to hear you tune it!)
Pedal: The onboard Pedal (as well as a connected Expression Pedal) can actually be assigned to control either Tone 1, Tone 2, or both Tones, and assigned to different functions (Wah, Volume, Tweak). Please refer to the following POD X3 System Configuration section for details on how to set up these pedal behaviors per Tone.

Pedal VOL & WAH Indicators: These two lights at the left of the onboard Pedal indicate the current mode. When both lights are lit this indicates the Pedal is controlling the assigned TWEAK parameter. For the TWEAK parameter, you can actually choose from a menu of many effect parameters to control with the pedal - see the following POD X3 System Configuration section.

FBV Express™ MkII

TAP TEMPO: To tap in a tempo for supported Delay and Mod effects to follow, just tap the currently lit A, B, C or D channel button. An LED within the Tuner display flashes to indicate the current tempo.

TUNER: Press and hold the currently lit A, B, C or D channel button for 2 seconds to switch to Tuner mode. You’ll see the onboard Tuner display become active. To exit tuner mode, simply press and release any channel button (and you’ll also be returned to the same tone preset). Or, pressing the pedal all the way forward and clicking the toe switch will exit the Tuner, (as well as toggle the pedal control between WAH and VOL).

**TIP:** You can also set the “AUDIO” behavior for the Tuner mode on the POD X3 directly on the POD X3 Tuner page to either MUTE your audible signal or not. (Sure, everyone likes to hear a guitar in tune, but they don’t necessarily want to hear you tune it!)

Pedal: The onboard Pedal can actually be assigned to control either Tone 1, Tone 2, or both Tones, and assigned to different functions (Wah, Volume, Tweak). Please refer to the following POD X3 System Configuration for details on how to set up these pedal behaviors per Tone.

Pedal VOL & WAH Indicators: These two lights at the left of the onboard Pedal indicate the current mode. When both lights are lit this indicates the Pedal is controlling the assigned TWEAK parameter. For the TWEAK parameter, you can actually choose from a menu of many effect parameters to control with the pedal - see the following POD X3 System Configuration section.

POD X3 System Configuration - Pedal Settings

There are several options you’ll want to check on the first page of the POD X3 SYSTEM screen for your FBV Shortboard or Express Pedal behaviors. On the POD X3, press and hold the OUTPUTS/Hold for System button to get to the SYSTEM screen.

---

**POD X3 System Configuration - Pedal Settings**

<table>
<thead>
<tr>
<th>SYSTEM</th>
</tr>
</thead>
<tbody>
<tr>
<td>CNTRL</td>
</tr>
<tr>
<td>BOTH</td>
</tr>
<tr>
<td>TONES</td>
</tr>
<tr>
<td>PEDAL</td>
</tr>
<tr>
<td>TONE1:</td>
</tr>
<tr>
<td>DELAY</td>
</tr>
<tr>
<td>MIX</td>
</tr>
<tr>
<td>TWK</td>
</tr>
</tbody>
</table>

*Page 1 of the POD X3 System screen*
The three PEDAL settings on the top row configure the behaviors of the Wah/Volume/Tweak Pedal on your FBV MkII device for the current preset. Note that a Pedal has several “modes” of operation, configurable to switch between controlling Wah/Volume/Tweak. The Pedal also has the ability to perform in these modes independently per Tone 1/Tone 2.

- **FBV Shortboard MkII** - Includes one onboard pedal, which is pedal “1”. When no Expression pedal is connected to FBV Shortboard, the pedal “2” options are not active (as indicated by these settings shown in parentheses (as displayed in the above System screen).

- When an Expression pedal is connected to FBV Shortboard, it becomes pedal “2”, and you’ll see the options for pedal 2 become active (displayed without parentheses in the System screen), as shown here:

  ![POD X3 System screen - Shortboard with Expression pedal](image)

- **FBV Express MkII** - Includes one onboard pedal, which is pedal “1”. There is no option for connecting a 2nd pedal, therefore, the pedal 2 options will be displayed in parentheses in the System screen to indicate they are not active.

All of these PEDAL, TWK and LP SW System settings are specific to the current preset - that is, you configure each of these settings and SAVE them with your current settings to have your FBV pedal(s) function however you like for each individual preset.

**Note:** Any preset location on your POD X3 can consist of either one or two separate Tones (Tone 1 and Tone 2.) The System settings here always allow you to view and edit settings for “Tone 2” even though the specific preset you are editing may not currently have Tone 2 active.

**PEDAL CNTRL** - Use this left-most PEDAL System setting to have the pedal affect either TONE 1, TONE 2 or BOTH TONES. (The default mode is BOTH TONES for all current Presets.) We’ve offered lots of flexibility here for allowing you to set pedal functions independently for each Tone in a preset, so please note the behaviors here:

- **TONE 1 ONLY** - Pedal 1 (and pedal 2, if connected) affects only Tone 1 and follows Tone 1's PEDAL “mode” settings, regardless of Tone 2's Pedal mode settings and on/off state.

- **TONE 2 ONLY** - Pedal 1 (and pedal 2, if connected) only affects Tone 2 and follow Tone 2's PEDAL mode settings, regardless of Tone 1's PEDAL mode settings and on/off state.

- **BOTH TONES** - Pedal 1 (and pedal 2, if connected) affects Tone 1 according to Tone 1's PEDAL mode settings, and simultaneously affects Tone 2 following Tone 2's PEDAL mode settings.

**Note:** For more about the FBV pedal options and behaviors with Dual Tone Presets, be sure to read the following section titled “Using Pedals with Tone 1 and Tone 2”.

2•5
**TONE1 PEDAL** - Use this TONE1 setting to configure the two “modes” of operation for Pedal 1 & Pedal 2 (if Pedal 2 is connected) for Tone 1. The settings here are strictly for Tone 1, and the value you have set for the PEDAL CNTRL setting (see previous) determines whether Tone 1 will be controlled or not by your pedal(s). Note that the pedal options differ if you have an FBV Shortboard with an Expression pedal connected.

The PEDAL TONE1 options for FBV Express and Shortboard **without** an Expression pedal are as follows:

- **1-W/V 2-VOL** - Pedal 1 controls the Wah or Volume effect's Position parameter, with the toe switch toggling between controlling these two effects for Tone 1. Pedal 2 options are not active.
- **1-TWK 2-VOL** - Pedal 1 controls the Tweak parameter that is currently assigned for Tone 1. (See the following TONE1 TWK section.) Pedal 2 options are not active.
- **1-W/V 2-TWK** - Pedal 1 controls the Wah or Volume effect's Position parameter, with the toe switch toggling between controlling these two effects for Tone 1. Pedal 2 options are not active.

The PEDAL TONE1 options for FBV Shortboard **with** an Expression pedal are as follows:

- **1-W/OFF 2-VOL** - Pedal 1 controls the Wah, with the toe switch toggling the Wah effect on/off. Pedal 1 performs no function when the Wah is off. Pedal 2 controls the Volume at all times.
- **1-TWK 2-VOL** - Pedal 1 controls the Tweak parameter that is currently assigned for Tone 1. (See the following TONE1 TWK description.) The toe switch performs no function. Pedal 2 controls the Volume for Tone 1.
- **1-W/V 2-TWK** - Pedal 1 controls the Wah or Volume effect's Position parameter, with the toe switch toggling between controlling these two effects for Tone 1. Pedal 2 controls the Tweak parameter that is currently assigned for Tone 1. (See the following TONE2 TWK description.)

**TONE2 PEDAL** - Use these TONE2 settings to configure the two “modes” of operation for Pedal 1 & Pedal 2 (if Pedal 2 is connected) for Tone 2. The options for the PEDAL TONE2 are the same as those described in the TONE1 PEDAL section above, but the settings here are strictly for Tone 2, to provide you with independent pedal behaviors per Tone. The values you have set for the PEDAL CNTRL setting (see previous description) determine whether Tone 2 will be controlled or not by your pedal(s). Also note the TONE2 TWK options below to configure what the TONE2 “Tweak” pedal options perform.

**TONE1 TWK** - (Tweak) If you’ve assigned one of the TONE1 PEDAL options to control TWK, this is where you choose the parameter that will be controlled with that TWK-assigned pedal. The list of available parameters is too long to list here - turn the knob and see what you find!

**TONE2 TWK** - (Tweak) If you’ve assigned one of the TONE2 PEDAL options to control TWK, this is where you choose the parameter that will be controlled with that TWK-assigned pedal. The list of available parameters is too long to list here - turn the knob and see what you find!

**TONE1 LP SW (Shortboard only)** - This LP SW (“Loop Switch”) setting allows you to choose what the FBV Shortboard FUNCTION1 switch actually controls for Tone 1. (Note that we’ve recently expanded this to offer more than just a “Loop Switch” option, so don’t the name fool you!) Your options for Tone 1 are:

- **COMP** - Toggles Compressor block on/off.
- **AMP** - Toggles Amp+Cab block on/off.
• **LOOP** - (POD X3 Pro only) Toggles the FX Loop on/off.

• **DUAL** - Performs the same toggling behavior between Tone 1 and Tone 2 as the TONE 2 (Hold For Dual) button on your POD X3 hardware, including the Hold For Dual function to enable/disable Dual Tone via footswitch.

**Note:** You'll see that changing to the DUAL option automatically also changes the TONE2 LP SW option to DUAL - this is necessary since both perform the same function.

**TONE2 LP SW (Shortboard only)** - This LP SW ("Loop Switch") setting allows you to choose what the FBV Shortboard FUNCTION2 switch actually controls for Tone1. Your options for Tone 1 are:

• **COMP** - Toggles Compressor block On/Off.

• **AMP** - Toggles Amp block On/Off.

• **LOOP** - (POD X3 Pro only) Toggles the FX Loop On/Off.

• **DUAL** - Performs the same toggling behavior between Tone 1 and Tone 2 as the TONE 2 (Hold For Dual) button, including the Hold For Dual function to enable/disable Dual Tone via footswitch.

**TIP:** Remember, these SYSTEM settings are specific to each User preset, so be sure to SAVE so that your edited settings are retained for the particular preset you are modifying!

### Using FBV Pedals with Tone 1 and Tone 2

Let’s take a look at the many options and behaviors available for using your FBV pedal (and optional Expression pedal) with Dual Tone presets. As described above, the TONE1 and TONE2 PEDAL mode options (Wah/Volume/Tweak) provide independent pedal assignments per Tone, (as well as per pedal, if you have FBV Shortboard with an optional Expression pedal connected). Therefore, when configuring these pedal options for a Preset, think about what you want to control in each Tone path. Here are some possibilities:

• Controlling a Wah in Tone 1 or Tone 2 only

• Controlling a Wah in both Tones simultaneously with a single pedal

• Controlling a Wah in Tone 1 with pedal 1 and a Wah in Tone 2 independently with pedal 2

• Controlling a Tweak parameter in Tone 1 or Tone 2 only

• Controlling a common Tweak parameter in both Tones simultaneously with a single pedal

• Controlling two different Tweak parameters in each Tone simultaneously with a single pedal

• Controlling a Tweak parameter in Tone 1 with pedal 1 and different Tweak parameter in Tone 2 with pedal 2

When you have a Dual Tone preset loaded, and PEDAL CNTRL set to BOTH TONES with the **same** mode settings for both the PEDAL TONE1 and PEDAL TONE2, then this FBV pedal and its toe switch will actually control this same effect for both Tones **simultaneously** (clever, eh?) For example, if you choose “1-W/V” for both PEDAL TONE1 and PEDAL TONE2, then your onboard FBV pedal will control the Wah or Volume effects for both Tones simultaneously. And clicking the toe switch will also simultaneously toggle between the Wah & Volume for both Tones.*
Likewise, if you set pedal 2 modes to “2-TWK” for both Tone 1 & 2, then the assigned Tweak parameters are simultaneously controlled for both Tones by pedal 2. It is also possible to actually set the TWK assignment independently, so that the specific parameter controlled by pedal 2 is independent for each Tone. For example, Tone 1 can be set to Tweak the Reverb Mix while Tone 2 Tweak the Delay Mix, resulting in the pedal adjusting both these parameters simultaneously!

*Note: It is possible to save a Dual Tone preset where the Wah effect block state is “on” in one Tone and “off” in the other. If the PEDAL CNTRL System setting is set to BOTH TONES, and the PEDAL is assigned to “1-W/V” for both Tone 1 & 2, the behavior for the pedal still remains “linked”, therefore, clicking the pedal's toe switch toggles each Tone's Wah effect to the opposite on/off state. You have the option of setting the Wah block’s on/off state using your POD onboard controls, and then saving the settings to the preset.

Likewise, the PEDAL “1-W/V” mode specifically dictates that the pedal toe switch toggles between controlling the Wah and Volume effects. Therefore, if both PEDAL TONE1 & PEDAL TONE2 are set to “1-W/V”, it is possible to manually set these two effects’ on/off states oppositely per Tone, resulting in toe switch toggling them both oppositely at the same time. The moral of the story here is that you can choose exactly how to configure each Tone and Save your User preset to achieve the behavior you want!

As you can see from the above examples, you can get some really weird effects by configuring your pedal(s) independently for Tone 1 and Tone 2 (and weird can be good!). The best practice is to create several different User presets and save the pedal configurations exactly how you want for each. This allows you to call up not only different sounds and effect combinations, but different methods of control over effects at the same time.

**Setting the Volume Pedal’s Min & Max Volume**

The POD X3 Volume effect can of course be controlled by the pedal(s) of your FBV MkII, and your POD X3 provides a few options for the Volume effect. To get to these settings, go to the POD X3 Home page, select the VOL effect block and double-click the ON/OFF button to enter the VOL edit screen:

![The POD X3 Volume page](image)

- **MIN** – Determines how much volume you’ll hear when the volume pedal is at its minimum (heel down) setting. Set it to 0% to have silence in the heel down position.
- **MAX** – Determines how much volume you’ll hear when the volume pedal is at its maximum (toe down) setting.
- **CONFIG** – Allows you to choose the position of the volume effect within the POD X3 signal flow: Pre (before the Amp+Cab), or Post (after the Amp+Cab).

Just like in the world of guitar effects stomp boxes and amps, the position of your Volume pedal in relation to some effects will impact the sound. For example, lowering the volume before a distortion
effect results in less gain - placing the volume after a distortion effect reduces the overall volume level without affecting the gain. With the Volume in the Pre position, and using the Delay effect, you can swell in your guitar volume and then roll the pedal back and still hear the delay repeats - but placing the Volume pedal Post conversely turns down the original signal AND the delay repeats... Get it?

Note that this VOL effect block is the same volume that is accessed by the POD X3 Tone Volume knob and, therefore, each Tone has its own independent VOL effect. So, if your preset has two Tones, then you can press the TONE 2 button to independently configure these three settings for Tone 1 and Tone 2. These VOL settings are also configurable for each preset, so you can set and save these settings differently for each User preset.

**Controlling Dual Tone Presets**

One of the coolest features of your POD X3 is that it offers two completely independent Tone Paths. It is possible for you to configure a “Tone Pair”, using Tone 1 for a guitar or bass that plugs into the POD X3 Input 1 jack and Tone 2 for a Mic plugged into Input 2. Alternatively, you can create a “Tone Blend”, where you utilize both Tone 1 and Tone 2 on a single input, such as to process a guitar with two amps, with each Tone having its own set of effects, speaker cabinet and mic! You’ll see that your POD X3 already comes loaded with Single Tone presets, as well as Tone Pairs and Tone Blends, so you can take a look at how these are constructed - as well as modify them to your heart’s content, and save your own creations as presets within the User folder.

For a thorough understanding of all this business of creating Dual Tones, please check out the “Dual Tone Concept” section of your POD X3 Pilot’s Handbook.

Your FBV MkII allows you to navigate through the 128 memory locations within the User folder. As mentioned above, some User presets might be composed with only a Tone 1, while others both a Tone 1 and Tone 2. This makes no difference as far as your FBV Channel (A, B, C, D) or Bank buttons are concerned, since the FBV unit will simply call up a channel location regardless if it holds a preset with one or two Tones active. However, it is important to take a look at what the other buttons on the FBV Shortboard MkII control when a Dual Tone preset is loaded.

FBV Shortboard MkII units include effect buttons (STOMP, MOD, DELAY, etc.) which allow you to modify the selected Tone of the currently loaded preset - stepping on one of these effect buttons will toggle on/off ONLY the function for the currently selected Tone. You can optionally configure your FBV MkII Shortboard FUNCTION 1 switch to perform the same functions as the TONE 2 button on the POD X3 unit. This allows you to toggle between Tone 1/Tone 2 as the “selected” Tone, as well as allows you to hold down the button to toggle the Dual Tone feature on/off. To configure the FUNCTION 1 button’s assignment, go to the SYSTEM screen on your POD X3 and access the LP SW options for Tone 1 and Tone 2 (see the LP SW descriptions starting on page 2•6).

TIP: When calling up one of the factory-created “Tone Pair” type of Dual Tone User presets, you’ll see we added an “L” and an “R” at the ends of many titles for Tone 1 and Tone 2 respectively. (Call up preset 12A as an example.) Adding a unique identifying character to each Tone’s title like this is handy when using an FBV Shortboard since this provides you with an easy reference on your FBV LCD screen for which of the two Tones is the one currently being controlled.

That about covers it! Armed with the above knowledge, you should now have vast control over the power embedded in your POD X3 or POD X3 Pro, all without your hands leaving your guitar. For more helpful information, please visit the Line 6 Online Support web page.
The Line 6 FBV Control Application

The previous “Getting Started” chapter should have already gotten you up and running with your Line 6 FBV™ MkII controller. In this chapter, we’ll provide you with an overview of the features and functions found in the Line 6 FBV Control application’s user interface. It is also good idea to read through this chapter before going on to the POD Farm 2, GearBox or 3rd Party Software chapters, since you’ll be using the FBV Control application for all those setups. The following chapters provide additional specifics about controlling your software.

What’s in it for Me?

Your new FBV Shortboard™ or FBV Express™ MkII is a pretty sophisticated piece of gear, capable of controlling not only Line 6 Amp and POD® devices (via an RJ45 cable connection), but also capable of controlling any software on your computer that receives common MIDI control messages (via a standard USB connection). The Line 6 FBV Control application is specifically for the latter function - it provides a simple yet powerful set of features to allow you to “program” specifically what type of MIDI message is sent from each of the footswitch and pedal controls to your desired software. Further, you can then store these control assignments as FBV Preset files, stored on your computer for recall anytime. Go ahead and tweak all you like to allow your FBV MkII hardware to do those naughty MIDI controller things you always wanted to try!

Graphical User Interface

In software speak, the main window of the Line 6 FBV Control application is referred to as the “Graphical User Interface” (or “GUI” if you want to sound hip around your software buddies). Here we’ve laid out descriptions for all the important things you need to know as you start clicking around in there. Refer to the numbered descriptions below for details.
Device Controls

1 - FBV Image: A graphical image of your selected FBV MkII device is displayed here. To edit the MIDI assignment for any control on your FBV, click directly on the footswitch or pedal in this image, or on the corresponding row in the Control Properties list below to select it. See the Control Properties List description on page 3•3 for edit options.

Note: The FBV Control application will automatically detect and select your USB-connected FBV device (Shortboard or Express MkII). However, you have some other options when launching with no FBV device or multiple FBV devices connected. See "Preferences" on page 3•9 for details.

2 - Footswitches: Click directly on any footswitch here to select it and its related row in the Control Properties List where you can edit its MIDI assignment. Note that all the footswitches on your FBV MkII hardware can be set to send any type of MIDI message available in the Control Properties list's columns - regardless of how the footswitch is labeled on your FBV hardware chassis. If you don’t want a particular footswitch to send any MIDI command at all, just choose “Unassigned” in the MIDI command column. (Also see “Footswitch LED Behaviors” on page 3•6 for info on these indicators.)

3 - Pedal Wah and Pedal Vol: These provide you with two assignable functions for your Shortboard or Express unit’s on-board pedal (we’ll refer to this as “Pedal 1” in this document). To edit the assignments for these Pedal 1 functions, click directly on the WAH or VOL indicator items in the image, respectively (or directly on their rows in the Control Properties list). You can assign these Pedal 1 functions to send any MIDI CC value you like so you can toggle between controlling two different functions in your software by pressing the pedal full forward and clicking the Toe Switch. Also see the next description about the Toe Switch for related functions. When the WAH LED is lit on your FBV hardware, this indicates that the Pedal “Wah” assignment is in use. When VOL LED is lit, this indicates Pedal “Vol” is in use.

4 - Pedal 1 Toe Switch: Click here to select the “Toe Switch” that is located beneath the on-board pedal. This switch actually has two functions:

- The Toe Switch can be assigned with any MIDI command, just like any other FBV Footswitch. This can be especially handy for some related Pedal-based effect parameters.
- Additionally, as a fixed, non-editable behavior, the Toe Switch will toggle Pedal 1 to utilize either the “Pedal Wah” or “Pedal Vol” assignment, as configured in the Control Properties list. The WAH and VOL LED lights on your FBV unit will indicate which function is currently in use. The Toe Switch always performs this action, regardless of the settings made to the Toe Switch options in the Control Properties list. This is an “internal” switch behavior and the Toe Switch does not transmit a MIDI command when performing this function. The only MIDI command transmitted from the Toe Switch is what you have assigned in the Control Properties List for this control.

Also see the “3 - Pedal Wah and Vol” description above for more about pedal settings.

5 - Pedal 2 (Shortboard only): FBV Shortboard MkII offers an “Expression Pedal” jack on the back where you can connect an optional expression pedal (such as the Line 6 EX-1). To edit the assignment for the expression pedal, click directly on this Pedal 2 area in the image, or directly on the Pedal 2 row in the Control Parameter list below. You can configure Pedal 2 to send any MIDI CC and value range to continuously control a “knob” or “slider” parameter in your software.
6 - Control Properties List: This list displays all editable Footswitch and Pedal controllers for your selected FBV Shortboard/Express MkII device. As mentioned in the above descriptions, you can click directly on a switch on the Device Controls - FBV Image, or click on any row here in the Control Properties List to select it and edit its MIDI settings. To follow are descriptions for each column and the options provided:

- **Control:** The static name of the physical Footswitch or Pedal, as labeled on your FBV MkII device. Note that this is just a label for the Control - you can choose whatever MIDI command you like for each Footswitch or Pedal Control, regardless of the name we've given each Control.

- **MIDI Command:** The type of MIDI message the Control will transmit. You can choose between the following types of MIDI commands for all Footswitches (note that Pedal Wah, Pedal Vol, and Pedal 2 Controls offer only the **MIDI CC** and **Unassigned** options):
  - **Unassigned:** Sends no MIDI data. Basically, this is to disable the Control. If you don’t plan on using some footswitches or pedals within the preset you are creating, it is best to set these to Unassigned to avoid unexpectedly triggering functions in your targeted software!
  - **Bank Change:** A numerical value typically used to load a Patch or Preset Bank.
  - **Program Change:** A numerical value typically used to load a Preset within a selected Bank.
  - **MIDI Continuous Control (MIDI CC):** A set of Value and Range numbers commonly used by MIDI software and hardware to provide access to parameters.
  - **MIDI Machine Control (MMC):** Specific commands for commonly used for controlling things such as transport parameters and mechanical functions (Play, Stop, Record, etc.)
  - **Mackie:** Specific commands in the “Mackie Universal Controller” format, commonly used for transport parameters and mechanical functions (Play, Stop, Record, etc.), for MIDI software that supports the Mackie Control format.

Note: FBV MkII devices transmit only the above types of MIDI Commands - they are not configurable to transmit MIDI Note data or MIDI SysEx dumps.

- **Value:** Allows you to choose a value for the selected MIDI Command. These options differ depending on the type of MIDI Command selected - see MIDI Command descriptions above.
  - If the MIDI Command is Bank Change or Program Change, with either Increment or Decrement as the Switch Mode, you can incrementally select a value of 1 thru 127* to select and load correspondingly numbered Banks/Presets.

  *Note: It is actually possible to select a value of “0” for the Bank or Program Change command type when set to the Increment/Decrement Switch Modes, however, this is not recommended since this is not a valid option for most MIDI applications to receive.

  - If the MIDI Command is Bank Change or Program Change, with Fixed as the Switch Mode, you can select any value of 0 thru 127 to load the corresponding Bank/Preset.

  - If the MIDI Command is MIDI CC, you can choose a value of 0 through 127, or Custom. If Custom is selected, the Toggle 1/Up and Toggle 2/Down options in this control row become selectable, so that the each Toggle action can be defined with its own separate MIDI CC value.

  - If the MIDI Command is MMC, you can choose between the options Play, Stop, Play/Stop, Record Punch-Pro Tools, Pause, Fast Forward, or Rewind.

  - If the MIDI Command is Mackie, you can choose between the options Play, Stop, Play/Stop, Record Punch, Pause, Fast Forward, or Rewind.
**Toggle1/Up Toggle2/Dn CC/Val Columns:** These columns become selectable when the MIDI Command is set to “MIDI CC” and Value is set to “Custom”. Individual values can be then be entered manually here to specify the Toggle 1/Up and Toggle 2/Down switch behaviors. (See “Footswitch Control Behaviors” on page 3•5 for details.)

**Port:** The FBV Control software MIDI Out port the data is to be sent out. The FBV MkII device offers four independent USB MIDI Out Ports that are selectable by other MIDI software on your computer to receive the MIDI Commands FBV is transmitting. You can choose Port 1, 2, 3, 4 or All independently for any Control.

**TIP:** If you want to use your FBV to control more than one software application at the same time on your computer, then you can set Controls to different Ports to allow each application to “listen” strictly on its own MIDI Port to receive only the intended Commands.

**Channel:** The MIDI Channel the data is sent out on the selected Port(s). You can choose any single channel, 1 thru 16. If you select “All” in the Ports column for the Control, the current MIDI Channel setting is used for all four MIDI Ports.

**Switch Mode:** The options available here are dependent on the currently selected MIDI Command. (There are no Switch Mode options for the Pedal Wah, Pedal Vol, or Pedal 2 controls.)

- If the **MIDI Command** is **Bank Change** or **Program Change**, the options available here are **Increment**, **Decrement**, or **Fixed**:
  - **Increment:** Sets the footswitch to increment thru Banks/Presets by the amount of 1 to 127*, as set in the Value column.
  - **Decrement:** Sets the footswitch to decrement thru Banks/Presets by the amount of 1 to 127*, as set in the Value column.

*Note: It is actually possible to select a value of “0” for the Bank or Program Change command type when set to the Increment/Decrement Switch Modes, however, this is not recommended since this is not a valid option for most MIDI applications to receive.

- **Fixed:** Sets the Footswitch action to jump to a specific Bank/Preset number 0 through 127, as set in the Value column.

**Note:** Any FBV Bank Change command always also transmits a Program Change as part of its MIDI message. This provides the behavior where the first preset is automatically recalled within the new, selected Bank. For example, if your software is currently on Bank #1 and preset #23, if your FBV Control is configured to send Bank Change_Increment_Value 1, this results in recalling Bank #2 and preset #1 in your target software.

- If the **MIDI Command** is **MIDI CC**, the options are **Single**, **Momentary**, or **Toggle** to provide these types of switch behaviors. Please also see “Footswitch Control Behaviors” on page 3•5 for the details on these switch modes.
- If the **MIDI Command** is **MMC** or **Mackie**, there are no selectable Switch Mode options. However, you will see that some MMC and Mackie commands will automatically set themselves to be “Toggle” behaviors, such as “Play/Stop” which alternates between sending these two messages.
7 - No Device Connection Indicator: If no FBV MkII device is detected when you launch the Line 6 FBV Control application, you’ll see this alert at the bottom of the application window, meaning that you either neglected to connect the FBV unit’s USB cable, or there is a problem detecting the device:

![No Line 6 device connected.]

If your FBV is disconnected, you can plug it into your computer’s USB port while the Line 6 FBV Control application is still open, and the application will automatically detect it momentarily.

Note to Windows® Users: An inherent behavior of the Windows® 7, Vista® & XP USB Class Compliant driver is that it does not permit more than one application at a time to utilize a common USB MIDI device’s MIDI port. The Line 6 FBV Control application utilizes the FBV MIDI In Port to send your edited Control settings to the FBV device. Therefore, you’ll want to avoid setting your MIDI/DAW software to enable the FBV MIDI In port if you want to be able to have FBV Control open at the same time and communicate with your FBV. (You typically only need to enable one of the FBV MIDI Out ports 1 through 4 within your MIDI/DAW software to receive MIDI commands from FBV.)

Footswitch Control Behaviors

As described within the Control Properties List section on page 3•3, the FBV MkII footswitch controls offer several different behaviors based on the type of MIDI Command and Value selected. When selecting MIDI CC as the Command type, you’ll have the choice between three different Switch Mode options; Single, Toggle, or Momentary. Each footswitch control is actually capable of transmitting either one or two MIDI CC commands (depending on the Switch Mode), which is handy for some software parameters. Different software manufacturers might utilize one switch mode or the other for their specific parameters, so you’ll need to check their documentation to determine the best switch mode choice. But we can provide some helpful examples of how these three switch modes work here.

For this example, let’s say you’ve selected the following options for the “A” footswitch control:

<table>
<thead>
<tr>
<th>Control</th>
<th>MIDI Command</th>
<th>Value</th>
<th>Port</th>
<th>Channel</th>
<th>Switch Mode</th>
<th>Toggle 1/Up</th>
<th>Toggle 2/Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>MIDI CC</td>
<td>065</td>
<td>3</td>
<td>1</td>
<td>Single</td>
<td>65</td>
<td>65/0</td>
</tr>
</tbody>
</table>

By selecting the “065” Value, this actually sets both the MIDI CC assignments for the footswitch control to CC #65. At the far right you can see this indicated in the “Toggle 1/Up” and “Toggle 2/Down” CC and Val fields (even though they are not editable, you can see the numerical settings that are in use). The specific Values are automatically configured for 127 and 0, respectively. With these settings, the resulting behaviors for each Switch Mode setting are as follows:

- **Single:** Always transmits only the Toggle 1/Up CC number and Value when the footswitch is pressed (CC 65 and Value 127 in our example).
- **Toggle:** Alternates transmitting the first and second CC & Value on each successive press (like an on/off switch). So, in our example, it will send CC 65/127 on the first press, and CC 65/0 on the next. Some software parameters utilize this type of switch mode for things such as toggling a function on and off. Typically, the Value of 0 - 64 toggles the parameter to its “off” state, and a Value of 65 - 127 toggles it to its “on” state. However, you will also find that some software titles utilize MIDI CC commands with the Momentary Switch Mode to toggle parameters on/off (see next bullet). You’ll want to check your documentation (or just try different Switch Modes with your software) to see which Modes work for your application.
• **Momentary**: Transmits the first CC & Value when the control is pressed down, then the second CC & Value when the control is released. This type of Momentary switch action is commonly used for a parameter such as a piano’s sustain pedal, where you want the sustain parameter “on” only while holding the footswitch down, and “off” when released. In our example, it will send CC65/127 while the switch is being pressed, and CC65/0 when the switch is released.

**MIDI CC - Custom Option**: Additionally, when you have selected the MIDI CC Command type, you’ll also see that you can choose “Custom” rather than a CC number within the Value field. This allows you to then edit the “Toggle1/Up” and “Toggle 2/Down” fields to manually enter in whatever you want for the first and second CC & Value settings. As mentioned above, the Momentary and Toggle Switch Mode options allow the footswitch to transmit each of these CC values, alternating between the two. This is useful if you want some very specific actions, such as alternating between triggering one software parameter with one stomp, and then another parameter with the following stomp of the switch.

**TIP for FBV Shortboard MkII**: Whenever you press a footswitch or move a pedal, the LCD display on your FBV device will also show abbreviated text indicating the MIDI message sent.

### Footswitch LED Behaviors

The top portion of every footswitch on your FBV MkII device includes an LED indicator. When using your FBV with the USB connection, these LEDs light up following the type of MIDI Command and Switch Mode that is sent by this footswitch.

Generally, the following Switch Mode settings produce these footswitch LED behaviors:

• The Switch Mode “Single” setting results in the LED lighting up every time the footswitch is pressed, with the LED not remaining lit on release of the switch. This indicates that the same MIDI Value is sent on each press.

• The Switch Mode “Toggle” setting results in the LED alternating between staying on or off on each successive press of the footswitch, to indicate that alternating MIDI Values are sent on each press.
  - In the case of a MIDI CC type command, a MIDI CC value of 0 to 64 means “On”, resulting in the LED remaining lit. A MIDI CC value of 65 to 127 means off, resulting in the LED being off.
  - Like the “Toggle” switch behavior above, the “Momentary” Switch Mode also sends two CC Values. However, The “Momentary” setting results in the LED remaining on while the footswitch is held down, since this is when the “On” MIDI Value is sent. The LED turns off upon release of the footswitch, since this is when the “Off” Value is sent.

• When the footswitch control is set to “Unassigned”, the footswitch LED is never lit when pressed or released, to indicate that no message is sent.

• For all other control settings, the footswitch LED lights up when pressed only, and does not remain lit.

It is important to note here that these LED behaviors are based only on these above control settings, as configured in the Control Properties list. The FBV MkII device does not receive or respond to MIDI data from your MIDI/DAW software.
Pedal Control Behaviors

The on-board pedal of your FBV MkII (as well as an optional, connected Expression pedal on an FBV Shortboard MkII) supports transmitting a MIDI CC type message, and will “sweep” the range of parameter from 0 to 100%. Obviously, the Pedal control is best used when assigned to a knob or slider type parameter in your software, so that you can have “hands-free” operation over it. Setting a Pedal function is pretty straightforward - simply choose MIDI CC as the MIDI Command and then select the MIDI CC number that corresponds to the target software parameter. The “range” Values of 0 to 127 are automatically set for you, to allow adjustment from 0 to 100% of the mapped parameter. (Some MIDI applications further allow you to set different minimum and/or maximum settings within the software itself - see your software’s documentation.)

Note that your on-board Pedal actually has two configurable Control settings in the Control Properties list - Pedal Wah and Pedal Vol. You can set each of these Controls independently, and then use the Toe Switch to toggle between the two mapped parameters! Please see the Pedal Wah and Pedal Vol descriptions on page 3•2 for details.

Opening and Saving FBV Presets

The Line 6 FBV Control application allows you to create, edit and save all the current settings within the application GUI as a “patch”, or FBV preset file stored on your computer hard drive. This means you can backup the complete settings currently loaded in your FBV Shortboard or Express MkII hardware’s internal memory, or numerous customized versions of those settings, as individual FBV presets and load any one of them into your FBV’s memory at any time. To follow are some details on how to manage FBV presets.

As mentioned earlier, whenever your FBV MkII device is USB-connected to your computer, and the Line 6 FBV Control application is launched with the device selected, the contents of the FBV device’s internal memory is automatically loaded into the Control application’s GUI. Additionally, whenever you edit any single setting in the Control application, the changes are automatically written to the internal memory of the FBV MkII device’s internal memory.

TIP: Even though all the settings within the Line 6 FBV Control application GUI are automatically stored on your connected FBV device, it is a good idea to always do a “Save” or “Save As” your current FBV device's settings as an FBV preset on your computer once you have completed editing the settings. This ensures you always have a “backup” of all your customized settings that you can easily load again later!

If you want to be able to open an existing FBV preset file to review or edit its settings without automatically loading the preset onto your FBV MkII device's internal memory, disconnect your FBV device from the USB port before launching the FBV Control application.

Open an Existing FBV Preset

- With your FBV Shortboard or Express MkII device connected to your computer's USB port, launch the Line 6 FBV Control application.
- Go to the File > Open menu within the application.
- By default, this should open to these directories:
  - Documents/Line 6/FBV (Mac®)
  - My Documents\Line 6\FBV (Windows®)
In the above directories you will find the “factory” FBV Presets we’ve included (e.g. “FBV-Default.fbv”). Simply select one of these files and click open.

This will load the FBV Preset into the FBV Control application’s GUI and automatically load it into the internal memory of your FBV MkII device.

Note that your FBV Shortboard/Express MkII device holds one complete FBV preset at a time. When opening a new preset file as described in these steps, it will REPLACE all the USB MIDI Control assignments in your FBV device’s internal memory with those from the newly opened .fbv preset file. Before opening a new preset file, you may want to Save the current settings as an FBV preset to your computer if you want to be able to recall these settings again later.

Saving an FBV Preset

While working in the Line 6 FBV Control application, you can Save all the current settings within the Control application’s GUI as an FBV preset file to your computer’s hard drive at any time. It is a good idea to do so whenever you have a set of commands you don’t want to forget so you can load them into your FBV device later on (remember the mantra - “Save early and Save often!”).

FBV Control follows the typical Mac® and Windows® software conventions:

- To Save the changes made to the current FBV Preset, overwriting the previous settings of this file, choose File > Save from the application’s menu.

- To Save a the changes made to the current FBV Preset as a new FBV Preset file, choose File > Save As from the application’s menu. You’ll then be prompted to name the file, and where to save it. To keep your FBV Preset files tidy and easy to find, you probably want to always save them in the directory where we already stored the factory presets during installation:
  - Documents/Line 6/FBV (Mac®)
  - My Documents\Line 6\FBV (Windows®)

TIP: You’ll see the name of your currently loaded preset appear with an asterisk following its title (e.g. “FBV-Default.fbv*”) at the top of the application window whenever the preset is in an “unsaved” state.

Editing and Saving FBV Presets with No Connected FBV Device

As mentioned above, you actually do not need to have your FBV Shortboard/Express MkII device USB-connected to run the Line 6 FBV Control application to edit or save preset files. You can still use the above steps to Open, Save or Save As FBV Presets on your computer. You might find this handy if you just want to do some edits or look over the settings of the FBV Preset files stored on your computer without also loading the Preset into your FBV device’s internal memory. To load any of these presets into the internal memory of your FBV MkII device, you’ll need to connect it to your computer’s USB port, and then open a saved FBV Preset as described above to have it auto-load into your FBV device’s memory.

When you launch the Line 6 FBV Control application without an FBV MkII device connected, you will need to instruct the application what type of device model format (Shortboard or Express MkII) to work in. This provides the perfect segue to the next section, where we’ll look at these options in the application Preferences.
Preferences

As is the case with most other software applications, we’ve placed a few of those more “geeky” settings away in the Preferences. To get to the Line 6 FBV Control application’s Preferences dialog:

- **Mac®** - Line 6 FBV Control > Preferences
- **Windows®** - File > Preferences

‘No Device’ Prompt

When no Line 6 FBV device is detected at startup, then the Line 6 FBV application has the option of displaying either an FBV Shortboard or Express MkII device configuration for its GUI. By default, you’ll always be prompted on startup with a dialog to choose which you prefer. If you do not want to be prompted, select the preferred device here. Alternatively, you can check that little “Do this every time” box at the bottom of the prompt dialog itself to set this behavior, and you can change it here in the Preferences any time.

Note that this does not affect how the Line 6 FBV application launches when your FBV MkII device is connected - It will automatically display the GUI for the connected FBV device type. Further, if you have more than one FBV MkII device type connected to your computer at the same time, such as both a Shortboard and Express MkII, then you’ll be prompted to select which you want the Line 6 FBV Control application to work with (so go ahead and buy a few FBV units if you like!).

Show Warning Dialog at Startup

This checkbox refers to that dialog that pops up when Line 6 FBV Control application starts, informing you about the important, automatic behavior where the changes you make within the software have instant effect on the memory stored within your connected FBV device. If you grow weary of this warning dialog, then you can uncheck this box here in the Preferences. Or, if you’ve hastily checked that “Don’t show again” box in the prompt dialog itself but want to the reminder back, you can come to the Preferences and check this box here to have the prompt appear again.
The ‘About Line 6 FBV Control Application’ Dialog

This dialog provides you with some helpful information about the application. To launch it go to:

- Mac® - Line 6 FBV Control > About Line 6 FBV Control
- Windows® - Help > About Line 6 FBV Control

Here you’ll see the following compelling information:

- The version number of the Line 6 FBV Control application.
- The FBV MkII device that is detected and currently in use by the application (or “None”, if you don’t have an FBV connected).
- The Device Firmware Version of the connected FBV MkII unit.
- Some copyright info that those legal folks of ours insist on.

Click anywhere on the dialog to exit.

TIP: Remember that you can run the Line 6 Monkey application with your FBV connected to your computer to check for and install the latest software & firmware versions for your device!

The FBV Shortboard MkII LCD Display

When you connect your FBV Shortboard MkII to your computer’s USB port, you’ll see the device’s LCD screen read “USB MODE” to indicate the FBV is now ready to operate as a USB MIDI Controller device.

Each time you press a footswitch or move a pedal, the LCD display will show abbreviated text informing you of the MIDI message that was just sent by this control. This text remains displayed until you press another control. For example, the display might show the following for a MIDI CC Command assignment:

```
CH 1 CC 111 VAL 127
```

This indicates that the control is transmitting out MIDI Channel 1, sending a MIDI CC 111 Command, with a CC Value of 127. If the Switch Mode setting for this control is set to “Toggle”, then you’d see the CC Value alternate with each successive click between the Toggle 1 and Toggle 2 CC Values, as configured in the Control Properties list. When using a pedal, you’ll see the MIDI CC Value change in real time, indicating the stream of CC values the pedal is actually sending.

Likewise, other MIDI Command settings result in the LCD displaying similarly abbreviated text to indicate the message being sent (e.g. “MMC PLAY” to indicate an MMC type Command, or “CH 1 PGM 1” to indicate a Program Change).
This chapter covers the use of your Line 6 FBV Shortboard™ MkII or FBV Express™ MkII to remotely control numerous parameters within the Line 6 POD Farm™ 2 standalone application and POD Farm™ 2 Plug-In. This allows you to expand the possibilities of POD Farm 2 even further by using your FBV MkII pedal to control a Wah, Volume or Pitch Bender effect, toggle any effects on/off, navigate your custom POD Farm 2 Setlists, control POD Farm 2 Plug-In parameters while writing DAW automation, and more! If you have not already done so, please connect your FBV Shortboard or Express MkII to your computer’s USB port and launch Line 6 Monkey to make sure your FBV is updated with the latest Device Firmware version - please see "Updating & Registering with Line 6 Monkey" on page 1•1.

What is POD Farm 2?

In case you’re wondering… Line 6 POD Farm 2 is the software available for owners of Line 6 USB audio interface products.* The POD Farm 2 standalone application provides a full-featured computer User Interface where you can access all those famous Line 6 guitar & bass amp, preamp, speaker cabinet, mic, and effects models. Using your Line 6 USB audio interface, this essentially provides you legendary POD tone right on your computer, which you can use to record into your favorite audio software or jam along with your favorite songs. Further, POD Farm 2 also includes the POD Farm 2 Plug-In and POD Farm Elements Plug-Ins, which run as audio effects plug-ins within all major DAW applications on your Mac® or Windows® computer. The POD Farm 2 standalone application and the POD Farm 2 Plug-In both support external MIDI control, and your FBV MkII device is the perfect USB MIDI controller device for the task!

*Note: The POD Farm 2 standalone application requires a Line 6 POD Studio™, TonePort™ or GuitarPort™ device. A POD Farm 2 license can also be purchased as an “Add-On” for a Line 6 POD®xt, POD® X3 units or for an iLok USB key to allow POD Farm 2 Plug-In to be run with one of these devices.

To purchase POD Farm 2, connect your Line 6 USB audio interface to your Mac® or Windows® computer, launch Line 6 Monkey and let the little monkey fellow show you the enlightened path to the download. Or, go directly to the http://line6.com/software/ page and download it from there.

If you have not already done so, also download and install the Line 6 FBV Control application. You’ll need this to load and edit the MIDI commands your FBV device will use to communicate with POD Farm 2. See the "The Line 6 FBV Control Application" on page 3•1 for download instructions.

About USB MIDI Ports & Channels

First, it is helpful to learn how all this MIDI communication works between your FBV MkII device and your computer. When connected to the USB port of your Mac® or Windows® computer, your FBV MkII device establishes one USB “MIDI In” port and four USB “MIDI Out” ports. These are not “physical” hardware ports that require you to use a mess of MIDI cables - your FBV communicates all its MIDI data across your USB cable to these “virtual” software MIDI ports. If you are going to be controlling the POD Farm 2 standalone application, you'll access these FBV MIDI Ports within the Preferences of the POD Farm 2 standalone application (see “POD Farm 2 Standalone Application - MIDI Input Configuration” on page 4•7). If you are to be controlling POD Farm 2 Plug-In, you'll need to configure the DAW hot software in which you are using the Plug-In to receive MIDI from these FBV MkII MIDI Ports (see “POD Farm 2 Plug-In - MIDI Input Configuration” on page 4•8).
MIDI Communication with your Software

With your FBV MkII device USB-connected to your computer, you typically just need to set your software application to receive MIDI control data from the specific MIDI Out port and MIDI channel to which your FBV device is transmitting. For example, in the Ableton Live® or Live® Lite software, the Preferences > MIDI/Sync dialog offers options to choose one or more MIDI controller devices. In your MIDI/DAW software, you'll see FBV MIDI Ports 1 through 4 from which to receive MIDI Control data.

Note: These four ports appear titled differently depending on your specific Mac® or Windows® operating system version - Please see the setup examples in the following sections.

By default, all your FBV MkII Control assignments are transmitted to the FBV MIDI Out Port 1. However, you can set any individual FBV control to transmit its MIDI control data to any FBV MIDI Out port 1 through 4 (see the FBV Control application’s Control Properties List section on page 3•1).

Windows® MIDI Port Communication

It is important to note that the Windows® USB Class Compliant driver, which is used for your FBV MkII device on Windows, inherently allows only one application to utilize each MIDI port at a time. The Line 6 FBV Control application, when open, uses the FBV MIDI In port and the MIDI Out port 4 for communication with your FBV device. Therefore, if you have another DAW software application currently running on your Windows® computer that is configured to also use these same FBV MIDI ports, only one application will be permitted to do so.

If you already have POD Farm 2 standalone application or your DAW software running, and one has the FBV MIDI In port enabled, trying to then launch the Line 6 FBV Control application will typically result in the FBV Control application failing to detect the connected FBV device, since it is “in use” by the other software. One possible solution is to disable the use of the FBV MIDI In port and FBV MIDI Out 4 port within your POD Farm 2 or DAW software. (You should be OK keeping the POD Farm 2 or DAW software enabled for receiving from the FBV MIDI Out ports 1 through 3, which allows you to still send MIDI Control commands from FBV to your software.) Otherwise, it is recommended to exit all other applications when using the FBV Control software to provide full MIDI port access for editing your FBV control settings.

Note: The Line 6 Monkey application also utilizes the FBV MIDI ports for its ability to detect and update your connected FBV device. It is always recommended that you exit the Line 6 FBV Control, as well as any MIDI/DAW software, before launching Line 6 Monkey.

MIDI Channels

Each USB MIDI Port carries 16 MIDI “channels.” You can think of MIDI channels just like channels on your TV - your TV is capable of receiving many “channels”, but you'll only be able to see the program you want to watch if you tune your TV set to the specific channel. Same thing here in the world of MIDI. By default, your FBV MkII device will transmit its MIDI data to Channel 1 on the selected MIDI Port for each control. However, you can set any individual FBV control to transmit to any MIDI Channel (see the FBV Control application’s Control Properties List section on page 3•1). You may find that your software offers options to receive only on a specific MIDI channel from the selected MIDI port, so you will want to be sure to configure any such MIDI Channel options to match those to which your FBV controls are transmitting. POD Farm 2 will receive MIDI on all 16 channels (however, when using POD Farm 2 Plug-In, you might need to set your DAW or MIDI track to receive from the channel to which your FBV is transmitting).
POD Farm 2 Pre-configured MIDI Assignments

POD Farm 2 standalone application and POD Farm 2 Plug-In come with a complete folder of Tone Presets that include “pre-configured” MIDI control assignments. To access these Tone Presets, select the “POD Farm 2” titled folder within the Presets View.

Select the “POD Farm 2” folder (or any of its sub-folders) within the Source Folders pane

![Source Folders](image)

The Tone Presets available within these folders include “pre-configured” MIDI control assignments

The POD Farm 2 Presets View

The pre-configured MIDI assignments allow any MIDI controller device to access several useful parameters for these POD Farm 2 Tones. Note that these Tones’ MIDI assignments are “Local” MIDI assignments - meaning, they are saved individually with each Tone Preset, and accessible within POD Farm 2 Plug-In, as well as in the POD Farm 2 standalone application.

Additionally, the POD Farm 2 standalone application includes several pre-configured “Global” MIDI assignments. These Global MIDI assignments, as the name suggests, are configured for POD Farm 2 system settings. These Global assignments are available regardless of the current Tone Preset, and persist within the POD Farm 2 application (it is not necessary to save your Tones to retain them).

With a Line 6 FBV MkII controller device, we’ve made things simple by providing a “POD Farm 2” FBV Control preset to configure your FBV device to access these Tones’ MIDI assignments instantly (see the next section).

“POD Farm 2” FBV MkII Control Presets

To provide a nice “jump start,” we’ve created “POD Farm 2” FBV MkII control presets that can be loaded on your device using the Line 6 FBV Control application. These FBV MkII control (.fbv file) presets load a complete set of MIDI commands on your device for instant POD Farm 2 functionality! It is recommended that you download and load the FBV control preset on your FBV MkII device before proceeding with configuring the POD Farm 2 standalone application or Plug-In for your FBV MkII device. These Presets are available for download from the POD Farm Online Help site:

- For FBV Shortboard MkII - Download the file named “POD Farm 2-Shortboard.fbv.”
- For FBV Express MkII - Download the file named “POD Farm 2-Express.fbv.”

Once you’ve downloaded the FBV control preset file for your device, launch the Line 6 FBV Control application to load the preset on your FBV MkII:
• On Mac, go to /Applications/Line 6 and double-click on Line 6 FBV Control
• On Windows, go to Start button menu\Programs\Line 6\Line 6 FBV Control

For additional info, please see “The Line 6 FBV Control Application” on page 3•1.

This automatically loads the complete set of “POD Farm 2” MIDI control settings into the internal memory of your FBV MkII device. These settings allow you to instantly access many useful “pre-configured” MIDI control assignments that already exist within POD Farm 2 (as covered in the previous section). You can view the existing MIDI assignments for any Tone Preset by looking in the POD Farm 2 “MIDI Assignments View” display (see “The POD Farm 2 MIDI Assignments View” on page 4•10). MIDI Bank & Program Change settings are also included in the FBV MkII presets to allow footswitches to navigate Setlists and their Tone Presets. Further, you can also customize these MIDI assignments individually for any POD Farm 2 Tone, and/or use the POD Farm 2 “MIDI Learn” feature to easily create your own MIDI assignments (see “MIDI Learn in POD Farm 2” on page 4•10).

With the “POD Farm 2” FBV control preset loaded in your FBV Shortboard or Express MkII device, the application’s Control Properties list will display all its MIDI settings.

### FBV Shortboard MkII

<table>
<thead>
<tr>
<th>Function</th>
<th>MIDI Command</th>
<th>Value</th>
<th>Port</th>
<th>Channel</th>
<th>Switch Mode</th>
<th>CC1</th>
<th>CC2</th>
<th>CC3</th>
<th>CC4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function 2</td>
<td>MIDI CC</td>
<td>017 - General Control 2</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>17</td>
<td>127</td>
<td>17</td>
<td>0</td>
</tr>
<tr>
<td>Bank Up</td>
<td>Program Change</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Increment</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Bank Down</td>
<td>Program Change</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Increment</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>A</td>
<td>Bank Change</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>Fixed</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>Bank Change</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Fixed</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>C</td>
<td>Bank Change</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>Fixed</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>D</td>
<td>Bank Change</td>
<td>3</td>
<td>1</td>
<td>1</td>
<td>Fixed</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Tap</td>
<td>MIDI CC</td>
<td>004 - Foot Control</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>4</td>
<td>127</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>Stump</td>
<td>MIDI CC</td>
<td>012 - Effect Control 1</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>12</td>
<td>127</td>
<td>12</td>
<td>0</td>
</tr>
<tr>
<td>Modulation</td>
<td>MIDI CC</td>
<td>013 - Effect Control 2</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>13</td>
<td>127</td>
<td>13</td>
<td>0</td>
</tr>
<tr>
<td>Delay</td>
<td>MIDI CC</td>
<td>014 - CC 14</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>14</td>
<td>127</td>
<td>14</td>
<td>0</td>
</tr>
<tr>
<td>Reverb</td>
<td>MIDI CC</td>
<td>015 - CC 15</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>15</td>
<td>127</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>Tone Switch</td>
<td>MIDI CC</td>
<td>102 - CC 102</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>102</td>
<td>127</td>
<td>102</td>
<td>0</td>
</tr>
<tr>
<td>Pedal Wt</td>
<td>MIDI CC</td>
<td>011 - Expression</td>
<td>1</td>
<td>1</td>
<td>Pedal</td>
<td>11</td>
<td>127</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pedal Vol</td>
<td>MIDI CC</td>
<td>007 - Channel Volume</td>
<td>1</td>
<td>1</td>
<td>Pedal</td>
<td>7</td>
<td>127</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pedal 2</td>
<td>MIDI CC</td>
<td>018 - General Control 3</td>
<td>1</td>
<td>1</td>
<td>Pedal</td>
<td>18</td>
<td>127</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

The above FBV Shortboard MkII MIDI control settings perform the following functions with POD Farm 2:

<table>
<thead>
<tr>
<th>FBV Shortboard MkII Control</th>
<th>POD Farm 2 Pre-configured Model &amp; Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank Up</td>
<td>Next Tone Preset within selected Setlist</td>
</tr>
<tr>
<td>Bank Down</td>
<td>Previous Tone Preset within selected Setlist</td>
</tr>
<tr>
<td>A</td>
<td>Selects Setlist 0, and recalls the “0” numbered Tone Preset within</td>
</tr>
<tr>
<td>B</td>
<td>Selects Setlist 1, and recalls the “0” numbered Tone Preset within</td>
</tr>
<tr>
<td>C</td>
<td>Selects Setlist 2, and recalls the “0” numbered Tone Preset within</td>
</tr>
<tr>
<td>FBV Shortboard MkII Control</td>
<td>POD Farm 2 Pre-configured Model &amp; Parameter</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>D</td>
<td>Selects Setlist 3, and recalls the “0” numbered Tone Preset within</td>
</tr>
<tr>
<td>Tap</td>
<td>Not in use</td>
</tr>
<tr>
<td>Stomp</td>
<td>“Stomp” effects (Distortions, Dynamics, Filters) - On/Off</td>
</tr>
<tr>
<td>Modulation</td>
<td>Mods - On/Off</td>
</tr>
<tr>
<td>Delay</td>
<td>Delays - On/Off</td>
</tr>
<tr>
<td>Reverb</td>
<td>Reverbs - On/Off</td>
</tr>
<tr>
<td>Toe Switch</td>
<td>Wahs - On/Off, Bender effect On/Off</td>
</tr>
<tr>
<td>Pedal Wah</td>
<td>Wahs - Adjusts Position knob</td>
</tr>
<tr>
<td>Pedal 2</td>
<td>No assignment</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FBV Shortboard MkII Control</th>
<th>POD Farm 2 Pre-configured Global Parameter (POD Farm 2 Standalone Only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function 1</td>
<td>A/B Switch - Toggles between Tone A and Tone B</td>
</tr>
<tr>
<td>Function 2</td>
<td>Tuner View - Toggles Tuner View display On/Off</td>
</tr>
<tr>
<td>Tap</td>
<td>Tap Tempo - Sets System Tempo</td>
</tr>
<tr>
<td>Pedal Volume</td>
<td>Adjusts the Mixer Tone A Level and Tone B Level</td>
</tr>
</tbody>
</table>

Pre-configured functions provided in POD Farm 2 by the POD Farm 2-Shortboard.fbv preset settings

- **Bank Up & Bank Down footswitches** - These two footswitches navigate through the Tone Presets within the currently selected Setlist.

- **A, B, C & D footswitches** - These footswitches each select the correspondingly numbered Setlist, as shown in the above table. Each also automatically loads the first Tone Preset within the selected Setlist (the Preset with “0” to its left). This allows you to then use the Bank Up & Down footswitches to navigate through all the Tone Presets within the selected Setlist.

Note that no Setlists exist within POD Farm 2 by default, therefore, the Bank Up & Down and A, B, C & D footswitches will not perform any function until you create up to four Setlists and add Tone Presets into the Setlists. Please see the POD Farm 2 Basic User Guide for info on creating & managing Setlists (accessible via the POD Farm 2 Help button, or from the POD Farm Online Help site).

- **Effect labeled footswitches and Pedal Wah** - These trigger the functions listed above within some of the POD Farm 2 Tone Presets. Note that not all Tone Presets include all these effects models and assignments - In most Tone Presets, a few effects models and MIDI assignments exist.

- **Toe Switch** - As listed in the table above, the Toe Switch may be assigned to either toggle a Wah model on/off, or the Bender model on/off in some of the Tone Presets within the “POD Farm 2” Source Folder. The Toe Switch additionally has a “hard-wired” function to toggle your FBV Shortboard MkII “Pedal 1” function between the “Pedal Wah” and “Pedal Volume” assignments.

- **Pedal 2** - This control accesses no pre-configured assignment setting. But, since the FBV preset sets Pedal 2 to transmit a MIDI CC command, you can still utilize the POD Farm 2 MIDI Learn feature to map these FBV controls to POD Farm 2 functions.

- **Function 1, Function 2 & Tap** - These controls are all set to access “Global” MIDI assignments, which only exist as pre-configured MIDI assignments in the POD Farm 2 standalone application and not in the Plug-In. (However, you can use MIDI Learn to create Global MIDI assignments.
manually within POD Farm 2 Plug-In for any of your FBV MkII controls!) You'll see more about Local & Global assignments and MIDI Learn in the following sections.

- **Pedal Volume** - Adjusts both the Tone A Level and Tone B Level faders within the POD Farm 2 Mixer View simultaneously. If your current POD Farm 2 configuration is a single Tone, then only the Tone A Level fader is controlled. Note that this is a Global MIDI assignment.

### FBV Express MkII

<table>
<thead>
<tr>
<th>Control</th>
<th>MIDI Command</th>
<th>Value</th>
<th>Port</th>
<th>Channel</th>
<th>Switch Mode</th>
<th>Toggle 1/0</th>
<th>Toggle 2/Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Bank Change</td>
<td>*1</td>
<td>*1</td>
<td>*1</td>
<td>Increment</td>
<td>*0</td>
<td>*0</td>
</tr>
<tr>
<td>B</td>
<td>Program Change</td>
<td>*1</td>
<td>*1</td>
<td>*1</td>
<td>Increment</td>
<td>*0</td>
<td>*0</td>
</tr>
<tr>
<td>C</td>
<td>Program Change</td>
<td>*1</td>
<td>*1</td>
<td>*1</td>
<td>Increment</td>
<td>*0</td>
<td>*0</td>
</tr>
</tbody>
</table>
| D       | Pedal Wah | MIDI CC | *007 - Expression | *1 | *1 | Pedal | *1 | 127 | *0 | *
| E       | Toe Switch | MIDI CC | 102 - Channel Volume | *1 | *1 | Toggle | *1 | 192 | 127 | 102 |

**POD Farm 2-Express.fbv preset settings, when loaded in the FBV Control application**

The above FBV Express MkII MIDI Controller settings perform the following functions with POD Farm 2:

- **A & B footswitches** - These footswitches select the previous and next correspondingly numbered Setlist, respectively. Each also automatically loads the first Tone Preset within the selected Setlist (the preset with the number “0” to its left). This allows you to then use the C & D footswitches to load Tone Presets within the selected Setlist.
- **C & D footswitches** - These footswitches select the previous and next correspondingly numbered Tone Preset within the currently selected Setlist, respectively.

Note that no Setlists exist within POD Farm 2 by default, therefore, the A, B, C & D footswitches will not perform any function until you create Setlists and add Tone Presets into the Setlists. Please see the **POD Farm 2 Basic User Guide** for info on creating and managing Setlists (accessible via the POD Farm 2 Help button, or from the POD Farm Online Help site).

- **Toe Switch** - As listed in the table above, the Toe Switch may be assigned to toggle a Wah model on/off, or the Bender model on/off in some of the Tone Presets within the POD Farm 2 Source.
Folder. The Toe Switch additionally has a “hard-wired” function to toggle your FBV Shortboard MkII “Pedal 1” function between the “Pedal Wah” and “Pedal Vol” assignments.

- **Pedal Wah** - Adjusts the “Position” knob for Wah models within some of the POD Farm 2 Tone Presets. In a few Tone Presets, one pedal may also control the Bender model’s “Position” knob, for some cool pitch bending action.

- **Pedal Volume** - Adjusts both the Tone A Level and Tone B Level faders within the Mixer View simultaneously. If your current POD Farm 2 configuration is a single Tone, then only the Tone A Level fader is controlled. Note that this is a “Global” MIDI assignment and only exists as a “pre-configured” MIDI assignment in the POD Farm 2 standalone application and not in the Plug-In. (However, you can use MIDI Learn to create this and other Global MIDI assignments manually with your FBV Express MkII!)

With these settings made on your FBV MkII, exit the FBV Control application and proceed with the steps to configure POD Farm 2 standalone application or Plug-In.

**POD Farm 2 Standalone Application - MIDI Input Configuration**

To use your FBV MkII device with the POD Farm 2 standalone application, you’ll first need to configure POD Farm 2 to receive MIDI from your connected FBV MkII device’s MIDI port(s).

If you want to control POD Farm 2 Plug-In, please proceed to “POD Farm 2 Plug-In - MIDI Input Configuration” on page 4•8. MIDI control of POD Farm 2 Plug-In requires configuring MIDI settings within your DAW software.

- Launch the POD Farm 2 Preferences dialog and go to the MIDI tab. Here you will be able to select any connected MIDI controller device or port. Note that you’ll see the four FBV MIDI Out ports named differently, depending on your computer’s operating system:

![Preferences - MIDI dialog on Mac OS® X](image1)

![Preferences - MIDI dialog on Windows® 7 & Windows® Vista](image2)
As the initial default, you'll see all ports for all Line 6 MIDI devices already selected. You may want to de-select all except the ones you want to use for POD Farm 2 control. Your settings will then be remembered on subsequent uses of the application.

In the above example you can see that we've chosen to receive MIDI from only the Port 1 output of the connected Line 6 FBV Shortboard MkII controller. (Note that our connected Line 6 UX2 device is also an option, since its Footswitch 1 & 2 connections can be configured to send MIDI commands as well, but we'll just be using FBV MkII, port 1 for this example.)

Click OK to exit the POD Farm 2 Preferences and complete the MIDI input configuration steps.

**POD Farm 2 Plug-In - MIDI Input Configuration**

POD Farm 2 Plug-In, like all audio effects Plug-Ins, is utilized within your DAW software’s audio tracks. POD Farm 2 Plug-In can receive MIDI from your FBV MkII USB MIDI Ports to allow remote MIDI control of its many parameters, however, it is necessary to route the MIDI communication through your DAW software to access POD Farm 2 Plug-In. This configuration can be slightly different among DAW applications, so it is recommend that you consult your DAW’s documentation for details. The process typically entails choosing to receive MIDI from your FBV MkII MIDI Port(s) within the DAW application, and then routing the MIDI in to one of the DAW’s MIDI tracks and out to the audio track where POD Farm 2 Plug-In is inserted.

To follow, we’ve provided a brief tutorial using the popular Ableton Live® DAW application for configuring an FBV MkII device to access the parameters within POD Farm 2 Plug-In. The steps are similar using other DAW applications, so this should serve as a good introduction.

**TIP:** For tutorials on setting up external MIDI control of POD Farm 2 Plug-In within several popular DAW applications, please be sure to grab the POD Farm 2 Recording Setup Guide - available for download from the POD Farm Online Help site!

With your FBV MkII device connected to your computer, launch the Ableton Live software, and go to:

- **Mac** - Ableton Live menu > Preferences > MIDI/Sync page
- **Windows** - Options menu > Preferences > MIDI/Sync page

Here you will see that Ableton Live automatically detects your FBV MkII MIDI Out ports. You might see additional devices’ MIDI Ports appear here as well, depending what other MIDI hardware/software you have installed on your computer.
Click both the “Track” and “Remote” buttons to “On” for your MIDI Input Port.*

*Ableton Live - Selecting FBV MkII as MIDI Inputs (Mac® OS X)*

*It is only necessary to turn on the MIDI In “Remote” option to allow Live to receive MIDI control data from the selected MIDI port. However, to allow Live to receive MIDI into a MIDI track you need to turn on the “Track” option - You'll need MIDI track input to route MIDI control data directly to POD Farm 2 Plug-In.

Note that when selecting the FBV MkII MIDI ports within your DAW, you'll see the USB MIDI port names titled differently, depending on your specific computer operating system (for FBV Express MkII, you'll see “Express” in place of “Shortboard” in these titles):

<table>
<thead>
<tr>
<th>MIDI Out Port</th>
<th>Mac OS® X</th>
<th>Windows® 7 &amp; Vista®</th>
<th>Windows® XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port 1</td>
<td>FBV Shortboard Mk II (Port 1)</td>
<td>FBV Shortboard Mk II</td>
<td>USB Audio Device</td>
</tr>
<tr>
<td>Port 2</td>
<td>FBV Shortboard Mk II (Port 2)</td>
<td>MIDIIN2 FBV Shortboard Mk II</td>
<td>USB Audio Device [2]</td>
</tr>
<tr>
<td>Port 3</td>
<td>FBV Shortboard Mk II (Port 3)</td>
<td>MIDIIN3 FBV Shortboard Mk II</td>
<td>USB Audio Device [3]</td>
</tr>
<tr>
<td>Port 4</td>
<td>FBV Shortboard Mk II (Port 4)</td>
<td>MIDIIN4 FBV Shortboard Mk II</td>
<td>USB Audio Device [4]</td>
</tr>
</tbody>
</table>

The next step is to insert POD Farm 2 Plug-In on one of your DAW audio tracks, and then configure your DAW tracks to route the MIDI data into POD Farm 2 Plug-In. For example, here is how to configure this in Ableton Live, where POD Farm 2 Plug-In is inserted on Audio track 1:

On a new MIDI track, set the Input to receive from the FBV MkII MIDI Port from which you are transmitting commands

Set the Output to be the Audio track where your POD Farm 2 Plug-In is inserted

The POD Farm 2 Plug-In should then appear as the “MIDI Output Channel” destination

Be sure to Arm the MIDI track to allow MIDI throughput

Configuring Ableton Live for FBV MkII MIDI Input to POD Farm 2 Plug-In
Once the above MIDI routing is configured, you are now ready to put that FBV MkII to use with the POD Farm 2 Plug-In!

**The POD Farm 2 MIDI Assignments View**

The MIDI Assignments View displays all MIDI control assignments for the current Tone Preset within the POD Farm 2 standalone application and POD Farm 2 Plug-In. As covered on page 4•3, if you've loaded the “POD Farm 2” FBV control preset within your FBV MkII device, then you'll be able to access the “pre-configured” MIDI assignments within the POD Farm 2 Tone Presets. Use the MIDI Assignments View to reference each MIDI assignment and each specific MIDI command and value required to control the assigned parameters. Use the Clear buttons to remove any existing assignment.

Local and Global MIDI Assignments

Note that “Local” MIDI assignments are specific to (and, therefore, saved with) the current POD Farm 2 Tone Preset. Many Tone Presets found in the POD Farm 2 Source Folder have Local MIDI assignments already saved with each Tone Preset file. “Global” MIDI assignments persist within the POD Farm 2 standalone application or current Plug-In instance, regardless of the Preset in use. The POD Farm 2 standalone application also includes several pre-configured Global MIDI assignments. Local and Global MIDI assignments can be created manually using your FBV MkII controller and the POD Farm MIDI Learn feature (see next section). For more details on the MIDI Assignments View, please refer to the **POD Farm 2 Basic User Guide**.

**MIDI Learn in POD Farm 2**

The POD Farm 2 MIDI Learn feature allows you to easily “map” your FBV MkII device’s footswitches or pedals to practically any POD Farm 2 parameter. You can use MIDI Learn to “customize” any POD Farm 2 Tone Preset to include any number of MIDI assignments from your FBV MkII device. The steps for using MIDI Learn are quite simple:

- In POD Farm 2 (standalone application or Plug-In), load a Tone Preset, or configure a Tone with the desired models.
- Double-click on any model in the Signal Flow View to load its Edit Panel in the Panel View.
- Within the Edit Panel, right click (Windows) or Ctrl+click (Mac) directly on the model's knob, slider or switch that you want to control remotely and select the **MIDI Control** menu.
• In the MIDI Control sub-menu, click **MIDI Learn**. This places POD Farm 2 into MIDI Learn mode, where it waits to receive a command from your connected MIDI control device.

• Now just stomp the footswitch or wangle the pedal on your FBV that you want to “map” to the selected parameter, and the FBV control will instantly be “learned” by POD Farm 2.

All POD Farm 2 parameters that offer MIDI Learn will “learn” any MIDI CC, Note-On or Pitch Bend type messages. Before using MIDI Learn, you must, therefore, assign these MIDI message types to the FBV MkII’s controls using the Line FBV Control application. Also note that most “on/off” switch parameters within POD Farm 2 will require that you set your controls’ MIDI CC switch modes to “Toggle” (to toggle the parameter between on and off) or to “Momentary” (to set the parameter to “on” only when the switch is held).

Also worth noting is that most popular DAW applications offer their own “MIDI Learn” capabilities, which are separate from the POD Farm 2 MIDI Learn functions covered here. Within DAW applications that offer MIDI control features, it is usually possible to use your FBV MkII to remotely access numerous DAW mix and track parameters, including POD Farm 2 Plug-In and other Plug-In parameters via the DAW application’s track options. We’ve covered these capabilities within the **“FBV™ MkII with 3rd Party Software”** chapter.

For more information on POD Farm 2 MIDI control, please see the additional POD Farm 2 documentation, available from the **POD Farm Online Help** site.
This chapter is specifically for using your Line 6 FBV Shortboard™ MkII or FBV Express™ MkII to control the Line 6 GearBox™ software. Let’s jump right in!

What is GearBox?

In case you’re wondering... The Line 6 GearBox software is available free to owners of Line 6 USB audio interface products (POD Studio™, TonePort™, GuitarPort™ devices).* GearBox provides a full-featured User Interface on your computer where you can access all those famous Line 6 guitar & bass amp, preamp, speaker cabinet, mic, and effects models. Using your Line 6 USB audio interface, this essentially provides you legendary POD® tone right on your computer, which you can use to record into your favorite audio software, jam along with your favorite songs, or sign up for the GuitarPort Online subscription service!

*Note: GearBox can also be used with POD®xt and POD® X3 as the connected USB audio interface device, however, it is recommended to connect your FBV MkII to these POD® devices directly via the RJ45 cable connection rather than connecting your FBV via USB to your computer. When you control your POD directly with your FBV MkII, you’ll see the GearBox controls respond as well!

To get GearBox, connect your Line 6 USB audio interface to your Mac® or Windows® computer, launch Line 6 Monkey and let the little monkey fellow show you the enlightened path to the download. Or, go directly to the http://line6.com/software/ page and download it from there.

If you have not already done so, also go ahead and download and install the Line 6 FBV Control application. You’ll need this to load and edit the MIDI control information your FBV device will use to communicate with GearBox. See the “The Line 6 FBV Control Application” on page 3•1 for details.

Get Connected

To run GearBox, you’ll of course need to connect your Line 6 USB audio interface to your computer, and you’ll additionally want to connect your FBV MkII device to another USB port. Once connected, follow these steps to configure GearBox to receive MIDI control data from your FBV MkII device.

• Launch GearBox from /Applications/Line 6/GearBox (Mac®), or Start menu\Programs\Line 6\GearBox (Windows®)
• In GearBox, go to GearBox > Preferences > MIDI/Control (Mac®), or Edit > Preferences > MIDI/Control (Windows®)
• In the MIDI Control settings, de-select the “Send MIDI” option and choose the first available Port of your connected FBV MkII device.*

Uncheck the “Send MIDI...” option

Select the first Port of your FBV MkII device here

• Click OK to exit the dialog.
* Note that the FBV MkII MIDI Out port names appear within differently depending on your computer operating system (for FBV Express MkII, you’ll see “Express” in place of “Shortboard” in these titles):

<table>
<thead>
<tr>
<th>MIDI Out Port</th>
<th>Mac OS® X</th>
<th>Windows® 7 &amp; Vista®</th>
<th>Windows® XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI Out Port 1</td>
<td>FBV Shortboard Mk II (Port 1)</td>
<td>FBV Shortboard Mk II</td>
<td>USB Audio Device</td>
</tr>
<tr>
<td>MIDI Out Port 2</td>
<td>FBV Shortboard Mk II (Port 2)</td>
<td>MIDIIN2 FBV Shortboard Mk II</td>
<td>USB Audio Device [2]</td>
</tr>
<tr>
<td>MIDI Out Port 3</td>
<td>FBV Shortboard Mk II (Port 3)</td>
<td>MIDIIN3 FBV Shortboard Mk II</td>
<td>USB Audio Device [3]</td>
</tr>
<tr>
<td>MIDI Out Port 4</td>
<td>FBV Shortboard Mk II (Port 4)</td>
<td>MIDIIN4 FBV Shortboard Mk II</td>
<td>USB Audio Device [4]</td>
</tr>
</tbody>
</table>

This completes the configuration needed within the GearBox software. Next we need to configure your FBV MkII to send the specific MIDI commands to trigger the desired GearBox functions. The easiest way to do this is to select the GearBox.fbv FBV control preset that we’ve provided with the Line 6 FBV Control application.

- Launch the Line 6 FBV Control application from /Applications /Line 6/Line 6 FBV Control (Mac®), or Start menu Programs\Line 6\Line 6 FBV Control (Windows®)
- Go to File > Open and choose the GearBox.fbv preset file from these locations:
  - /Documents/Line 6/FBV/Presets (Mac®)
  - /My Documents\Line 6\FBV\Presets (Windows®)

This automatically loads the complete set of GearBox MIDI control assignments into the internal memory of your FBV MkII device. The Control Properties list should now display all these settings:

![GearBox.fbv preset settings loaded on FBV Shortboard MkII](image1)

![GearBox.fbv preset settings loaded on FBV Express MkII](image2)
As a handy reference, the following table tells what each FBV control will actually trigger in GearBox when using this GearBox.fvb preset:

**FBV Shortboard MkII**

<table>
<thead>
<tr>
<th>FBV Control</th>
<th>GearBox Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>FUNCTION 1</td>
<td>Comp effect on/off</td>
</tr>
<tr>
<td>FUNCTION 2</td>
<td>Amp/Preamp on/off</td>
</tr>
<tr>
<td>BANK UP</td>
<td>Player Transport - Play/Stop toggle</td>
</tr>
<tr>
<td>BANK DOWN</td>
<td>Player Transport - Rewind</td>
</tr>
<tr>
<td>A</td>
<td>Gate effect on/off</td>
</tr>
<tr>
<td>B</td>
<td>EQ effect on/off</td>
</tr>
<tr>
<td>C</td>
<td>No assignment</td>
</tr>
<tr>
<td>D</td>
<td>No assignment</td>
</tr>
<tr>
<td>TAP</td>
<td>Tap Tempo</td>
</tr>
<tr>
<td>STOMP</td>
<td>Stomp effect on/off</td>
</tr>
<tr>
<td>MODULATION</td>
<td>Modulation effect on/off</td>
</tr>
<tr>
<td>DELAY</td>
<td>Delay effect on/off</td>
</tr>
<tr>
<td>REVERB</td>
<td>Reverb effect on/off</td>
</tr>
<tr>
<td>TOE SWITCH*</td>
<td>Wah effect on/off</td>
</tr>
<tr>
<td>PEDAL WAH</td>
<td>Wah Position</td>
</tr>
<tr>
<td>PEDAL VOL</td>
<td>Volume Position</td>
</tr>
<tr>
<td>PEDAL 2</td>
<td>Delay Mix Level</td>
</tr>
</tbody>
</table>

* The Toe Switch additionally has a hard-wired function to toggle between the Pedal's, “Wah” and “Vol” assignments.

**FBV Express MkII**

<table>
<thead>
<tr>
<th>FBV Control</th>
<th>GearBox Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BANK UP</td>
<td>Player Transport - Play/Stop toggle</td>
</tr>
<tr>
<td>BANK DOWN</td>
<td>Player Transport - Rewind</td>
</tr>
<tr>
<td>A</td>
<td>Gate effect on/off</td>
</tr>
<tr>
<td>B</td>
<td>EQ effect on/off</td>
</tr>
<tr>
<td>C</td>
<td>No assignment</td>
</tr>
<tr>
<td>D</td>
<td>No assignment</td>
</tr>
<tr>
<td>TOE SWITCH*</td>
<td>Wah effect on/off</td>
</tr>
<tr>
<td>PEDAL WAH</td>
<td>Wah Position</td>
</tr>
<tr>
<td>PEDAL VOL</td>
<td>Volume Position</td>
</tr>
</tbody>
</table>

* The Toe Switch additionally has a hard-wired function to toggle between the Pedal’s, “Wah” and “Vol” assignments.

With these settings you should now be up and running - try stomping on your FBV footswitches and pedal and you should see, and hear, GearBox respond!
Customize Your GearBox Control

The above settings are great, but now you want more control you say? No problem! Many GearBox functions are capable of being controlled remotely, via MIDI commands. All you need to do is edit the settings within the Line 6 FBV Control application, entering the MIDI command assignments for the desired GearBox functions.

First you’ll need to see what the necessary MIDI commands are for all of the GearBox functions. This information is available in the handy Line 6 MIDI CC Reference document, available for download from the FBV MkII Online Help page. Take a look at the document’s GearBox MIDI CC Reference Chart for the list of GearBox functions and their MIDI CC number and value assignments. Also see the GearBox Model Tables for the list of Amp & Effects models’ MIDI CC assignments.

Configure your FBV Pedal to Control a GearBox Knob Parameter

There are also lots of knobs in GearBox, and you can configure your FBV MkII Pedal (as well as the optional Expression Pedal on a Shortboard) to just about any of these GearBox knobs! For example, say you want to have your FBV PEDAL WAH control adjust the GearBox Modulation Mix parameter rather than the Wah Position parameter. Looking at the GearBox MIDI CC Reference Chart, the Modulation Mix parameter lists its MIDI CC assignment as CC # 56, with Min. and Max Range Values of 0 to 127:

This tells you that you need to create these settings in the Line 6 FBV Control application for the “PEDAL WAH” row in the Control Properties:

- **MIDI Command:** MIDI CC
- **Value:** CC# 056
- **MIDI Port:** 1 (Optionally, you can choose any available port here, but your GearBox MIDI In setting needs to match to receive the command - see “Get Connected” on page 5•1.)
- **MIDI Channel:** 1 (GearBox receives MIDI on Channel 1 only.)

The Min. and Max Range Values shown in the MIDI CC Reference chart tell you that this parameter can be controlled from 0 to 100% (the equivalent of 0 to 127 in MIDI CC value terms). Therefore, there are no other settings you need to create for the Pedal to control the full range of the Modulation Mix parameter. You can follow these same steps to configure your FBV pedal for any other parameter you see in the GearBox MIDI CC Reference Chart.

TIP: Want to set your Pedal to control the GearBox Bender Position knob, to foot-control some wild pitch bending? In the Line 6 FBV Control - Control Properties, set one of your Pedal settings to “MIDI CC” for the MIDI Command and “CC 79” for the Value. In GearBox, you probably want to set the Bender effect’s Mix knob to 100% so you hear only the pitch effected signal, and set the Heel and Toe knobs to the desired amount of pitch change (these are in semi-tones), and “wham” on that pedal!
Configure a Footswitch to Toggle your Amp or Effects On/Off

The GearBox.fbv preset already configures the GearBox amp and effects items to be “toggled” on/off, but if you want to change the assignment of any switch, you can refer to the Line 6 MIDI Continuous Controller Reference PDF, and take a look at the GearBox MIDI CC chart. Look up the desired GearBox effect parameter and note its CC number. For example, say you want to make your “C” labeled FBV footswitch toggle the GearBox Delay effect on and off. In the GearBox MIDI CC chart, you’ll see this has CC #28 listed as the assignment:

You can also see in the Notes column that the CC Values of 0-63 will set the Delay “Off”, and 64-127 will set the Delay “On”. But you do not need to manually configure these CC toggle values, since setting the Switch Mode for your FBV footswitch control to “Toggle” will set them automatically for you, so that the MIDI message sent alternates between “127” (On) and “0” (Off) for each successive press of the footswitch. Therefore, the settings you want to enter into the FBV Control application’s Control Properties list for the “C” footswitch control are as follows:

- **MIDI Command:** MIDI CC
- **Value:** CC# 028
- **MIDI Port:** 1 (Optionally, you can choose any available port here, but your GearBox MIDI In setting needs to match to receive the command - see “Get Connected” on page 5.1.)
- **MIDI Channel:** 1 (GearBox receives MIDI on Channel 1 only.)
- **Switch Mode:** Toggle

Configure a Footswitch to Control the GearBox Player Transport

The **Player** module within GearBox allows you to load and play audio files from a CD or your computer hard drive, or to play GuitarPort Online membership Lessons & Tracks. If you want to keep your hands on your guitar while jamming along with the Player, then you can assign any of your FBV footswitches to control the Player’s Rewind, Play, Stop or Fast Forward transport options. To do so, simply set the MIDI Command to “Mackie” and then choose the desired function in the Value column, as shown here:

OK, you should now be all set with your FBV with GearBox, so stop mousing around on that computer and focus on the music!
FBV™ MkII with 3rd Party Software

Once you have things connected and powered up (if you haven’t, then head on back to “Getting Started” on page 1.1), you should now be ready to put your Line 6 FBV Shortboard™ MkII or FBV Express™ MkII device to work to remotely control your favorite software applications! Here we’ve included some helpful tips and examples for how to configure MIDI and DAW software applications to respond to your FBV MkII device.

About USB MIDI Ports & Channels

When connected to the USB port of your Mac® or Windows® computer, your FBV MkII device establishes one USB “MIDI In” port and four USB “MIDI Out” ports on your computer. These are not “physical” ports that require you to use a mess of MIDI cables - your FBV communicates all its MIDI data across your USB cable to these “virtual” software MIDI ports.

The FBV MIDI In port is utilized by your FBV MkII device to receive MIDI information, and its primary function is to allow your FBV to communicate with Line 6 Monkey and FBV Control applications. You likely will not be using this MIDI In port with other software, since your desired use of your FBV is to transmit MIDI commands, which it does via its MIDI Out ports. You’ll be able to access these FBV MIDI Ports within the Options or Preferences settings of any software on your computer that supports MIDI communication.

Windows® MIDI Port Communication

It is important to note that the Windows® USB Class Compliant driver, which is used for your FBV MkII device on Windows® 7, Vista® and XP, inherently will not allow more than one application utilize one USB MIDI port at a time. The Line 6 FBV Control application, when open, uses the FBV MIDI In port and the MIDI Out port 4 for communication with your FBV device. Therefore, if you have another MIDI/DAW software application also currently running on your Windows® computer that is configured to also use these same FBV MIDI ports, only one application will be permitted to do so.

If you already have your MIDI/DAW software running, and it has the FBV MIDI In port enabled, trying to then launch the Line 6 FBV Control application will typically result in the FBV Control application failing to detect the connected FBV device, since it is “in use” already by the other software. One possible solution is to disable the use of the FBV MIDI In port and FBV MIDI Out 4 port within your MIDI/DAW software to permit you to still use it while also using the FBV Control application. (You should be OK keeping the MIDI/DAW software enabled for receiving from the FBV MIDI Out ports 1 through 3, which allows you to still send MIDI Control commands from FBV to your software.) Otherwise, you should exit all other MIDI/DAW applications when using the FBV Control software to provide full MIDI port access to the FBV Control software for editing your FBV control settings.

Note: The Line 6 Monkey application also utilizes the FBV MIDI ports for its ability to detect and update your connected FBV device. It is always recommended that you exit the Line 6 FBV Control, as well as any MIDI/DAW software, before launching Line 6 Monkey.

Setting your Software to Receive Communication from your FBV MkII

Most MIDI and DAW applications have options within their “Preferences” or “MIDI Options” dialogs where you’ll need to select your FBV MkII device and/or the FBV USB MIDI port to allow the application to receive your FBV device’s commands. These options may be presented differently in your MIDI/DAW software.
Control Surface Options

Some applications specifically offer a selector to choose one or more connected “Control Surface” or “MIDI Controller” devices, and you should first look to see if your software offers this type of option. You should see 4 selectable options for your connected FBV MkII device - one for each MIDI Out Port. Note the slight differences for how your FBV MkII MIDI Out ports appear within computer operating systems (for FBV Express MkII, you'll see “Express” in place of “Shortboard” in these titles):

<table>
<thead>
<tr>
<th>MIDI Out Port</th>
<th>Mac OS® X</th>
<th>Windows® 7 &amp; Vista®</th>
<th>Windows® XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI Out Port 1</td>
<td>FBV Shortboard Mk II (Port 1)</td>
<td>FBV Shortboard Mk II</td>
<td>USB Audio Device</td>
</tr>
<tr>
<td>MIDI Out Port 2</td>
<td>FBV Shortboard Mk II (Port 2)</td>
<td>MIDIIN2 FBV Shortboard Mk II</td>
<td>USB Audio Device [2]</td>
</tr>
<tr>
<td>MIDI Out Port 3</td>
<td>FBV Shortboard Mk II (Port 3)</td>
<td>MIDIIN3 FBV Shortboard Mk II</td>
<td>USB Audio Device [3]</td>
</tr>
<tr>
<td>MIDI Out Port 4</td>
<td>FBV Shortboard Mk II (Port 4)</td>
<td>MIDIIN4 FBV Shortboard Mk II</td>
<td>USB Audio Device [4]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MIDI In Port</th>
<th>Mac OS® X</th>
<th>Windows® 7 &amp; Vista®</th>
<th>Windows® XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI In Port 1</td>
<td>FBV Shortboard Mk II (Port 1)</td>
<td>FBV Shortboard Mk II</td>
<td>USB Audio Device</td>
</tr>
</tbody>
</table>

TIP: Also see “Ableton Live® - FBV MkII Setup Tutorial” on page 6•4 for examples of how FBV MkII appears as a selectable MIDI Controller in the Live Preferences dialog.

You'll want to select the FBV MIDI Out Port to which your FBV Controls are transmitting. By default, all FBV MkII Control assignments are configured to transmit to the FBV MIDI Out Port 1, but you can change this MIDI Out Port setting per Control within the Line 6 FBV Control application’s Control Properties List (see page 3•3).

Note: You do not need to select the FBV MIDI In Port within any of your MIDI/DAW software, since you will not want to feed MIDI from your software to the FBV device. (The Line 6 FBV Control and Monkey applications utilize the FBV MIDI In for communication, but no settings are necessary for this.)

In many cases, this is all the configuration needed, and the MIDI/DAW software will then receive your FBV MIDI commands. Some applications, however, offer additional options to choose the brand or type of MIDI controller device to communicate properly with it. For applications that offer this, you'll want to look for the option to choose a “generic” controller device. Further, some applications also allow you to rename your MIDI Device port names, giving them more “friendly” titles. See your MIDI software’s Help documentation for specific instructions. You can also check the following sections to see examples of a few popular MIDI application examples.

MIDI Input Options in your Software

In some MIDI and DAW applications' Preferences or MIDI Options, you may see only a set of “MIDI Input” settings (rather than a specific “Control Surface” or “MIDI Control” option, as described above). If your MIDI/DAW software's documentation instructs you to use this for selecting MIDI controller devices, then you'll want to select the FBV MIDI Port to which your Controls are transmitting. By default, all your FBV MkII Control assignments are transmitted to the FBV MIDI Out Port 1, but you can change this MIDI Out Port setting per Control within the Line 6 FBV Control application’s Control Properties List (see page 3•3).
MIDI Channels

Each USB MIDI Port carries 16 MIDI channels. By default, your FBV MkII device is configured to transmit its MIDI data to Channel 1 on the selected MIDI Port for each Control. However, you can set any individual FBV Control to transmit its MIDI control data to any MIDI Channel (see the “Control Properties List” section on page 3•3).

You may find that your software offers options to choose one specific MIDI channel from the selected MIDI port, so you will want to be sure to configure any such MIDI channel options to match those that your FBV Controls are transmitting to. This allows you to set your FBV MkII controller to transmit all its MIDI commands out one common MIDI port, yet with some of its individual controls fed to different channels, thus allowing your MIDI/DAW software to “filter” and receive only the desired commands. Consult your software’s documentation for info on its MIDI channel options.

MIDI Learn Functionality

Many MIDI and DAW software applications make using an external MIDI controller very easy by way of a “MIDI Learn” functionality built into their software. With a MIDI Learn feature, you typically click on the desired knob/slider/switch in the GUI of the software to place it in a “Learn” mode. Then you simply access the control on your FBV MkII device and the software instantly maps the accessed FBV switch/pedal to control the selected parameter. For example, Propellerhead Reason and Ableton Live applications provide exactly this type of functionality for most of their parameters - including their transport buttons, mixer faders, track options, and even their synth & effects parameters!

For applications that offer this “MIDI Learn” capability, you'll want to be sure that your FBV MkII footswitch and pedal controls have MIDI commands assigned so that the target software has something to “learn”. The nice thing about a MIDI Learn feature is that, typically, you need to only configure your controller to transmit MIDI CC commands of any Value - the software simply listens and learns whatever it receives when in “learn” mode. Some applications’ parameters might also require a specific “Switch Type” setting though (Single, Toggle or Momentary). As always, it is a good idea to read through your MIDI/DAW software’s documentation on its MIDI Learn options for details (or, some applications have such a feature with a different name). Please see the tutorials for several popular DAW applications later in this chapter for some helpful examples!

For use with your MIDI Learn software, you can set each FBV MkII control to send a different MIDI CC command and the software will utilize this communication with FBV. To configure these settings, use the Line 6 FBV Control application’s “Control Properties List” section options (see page 3•3), or try loading the “FBV-Default.fbv” preset we’ve provided as a starting point, and customize it as needed.

Manual MIDI Control Assignment

For applications that do not offer a “MIDI Learn” feature, then the process is more of a manual one, where you'll need to acquire MIDI reference documentation from the software manufacturer that lists specifically what MIDI Commands and Values are already assigned for the parameters within the software. Typically, applications utilize MIDI CC commands for their parameters, Bank & Program Change commands for switching patches, and sometimes MMC or Mackie commands for transport buttons. With the manufacturer's MIDI reference documentation in hand, you can then use the Line 6 FBV Control application to assign your desired FBV Footswitch/Pedal controls to trigger the desired software parameters.

You’ll want to consult the documentation that comes with your MIDI/DAW software for details on how to access its MIDI Control setup and the necessary MIDI command assignments, since most applications differ in how they offer these options.
Ableton Live® - FBV MkII Setup Tutorial

We've provided a step-by-step tutorial here for how to configure the popular Ableton Live software's functions to be controlled by an FBV Shortboard or Express MkII device. For this example, we're using Ableton Live version 8, but the steps are similar for most recent Ableton Live versions (including the Live Lite Line 6 version you might have received with your other Line 6 gear!) Ableton also offers a free downloadable demo of Live at www.ableton.com/downloads should you want to try it out. This tutorial should help you grasp the basics for how to set up other MIDI/DAW software for your FBV MkII Controller, however, most such applications vary to some degree in their MIDI options and features, so be sure to check your software’s documentation for more specifics!

Note: For the following steps, we’re running a Mac®, but the steps are the same if you are using Windows® 7, Vista® or XP, unless otherwise noted.

FBV Control Assignment Configuration

The first step, before even launching Ableton Live, is that we'll need to configure a set of MIDI assignments for the footswitches and pedals of our FBV device. Ableton Live, like many other DAW applications, utilizes MIDI CC commands to access most of its parameters. Therefore, we're going to assign MIDI CC commands to our FBV footswitch and pedal controls using the Line 6 FBV Control application, and save these settings as an FBV preset:

• Connect your FBV MkII device to your computer and launch Line 6 FBV Control.
• Go to File > Open and load the “Blank.fbv” preset.
• Go to File > Save As and let’s title this new preset “Live.fbv”.

Ableton Live incorporates a “MIDI Learn” type of functionality for setting up MIDI Control devices (see “MIDI Learn Functionality” on page 6•3 for more about this). So, this means it really does not matter specifically what MIDI CC numerical Value we assign to each Control, as long as each Control is sending a unique CC Value.

For this example, we'll configure several FBV Controls as follows (you can do the same on either an FBV Shortboard or Express MkII device):

• Assign the A, B, C & D footswitch Controls to use MIDI CC's 001 thru 004, respectively.
• Set the Switch Mode for the A, B, C & D Controls to “Single”, since we want each press of a footswitch to send the same single MIDI CC command each time.
• Assign the Pedal Wah and Pedal Vol Controls to use MIDI CC's 5 and 6, respectively.
• Set the Port and Channel for all of the above Controls to “1”, since we want to transmit all our MIDI commands to the FBV USB MIDI Out Port 1, Channel 1.
• For all other FBV Controls, we'll keep them to “Unassigned” since we won't be using them right now.

The result should appear in the Control Properties list like this:
Once you have all these settings created, go to File > Save to save the preset, and exit the FBV Control application.

**Ableton Live MIDI Input Device Configuration**

Next, we need to configure Ableton Live to receive MIDI commands from the FBV Controller device:

Launch the Ableton Live software, and go to Ableton Live > Preferences > MIDI/Sync page (Mac®) or Options > Preferences > MIDI/Sync page (Windows®). Here you will see that Live automatically detects all four of the FBV MIDI Out Ports. You might see additional devices’ MIDI Ports appear here as well, depending what other MIDI hardware/software you have installed on your computer.

*Note that the names of these Ports will appear differently if you are running Mac OS® X, Windows® XP, Vista® or 7, as shown below.*

- Click on the Remote button to the right of the first FBV MIDI Out Port so it is “On”, and then deselect any other active “On” buttons in the Track, Sync and Remote columns so that all others are “Off”, as shown in the following screen shots. This allows Ableton to receive MIDI Control commands from your FBV MIDI Out Port 1.
The same applies in Windows® XP, Vista® & 7, but you'll see the FBV Port names are listed differently.

Now go to the Input menu in the top row of the dialog and select the same FBV Port 1 device. This allows Live to utilize your FBV as a MIDI Controller Input device. Once again, you'll see these FBV port names listed differently, as shown above for Mac® versus Windows®, so just choose the first FBV USB MIDI port in the menu list.

Close the Preferences dialog - this completes MIDI input device configuration steps.

### Map FBV Controls

Next we need to “map” the FBV Controls to a few of the Live functions. Live refers to this process as “manual mapping”, and we need to enter the Live “MIDI Map Mode” (some other applications refer to this type of process as “MIDI Learn”).

To enter MIDI Map Mode, click on the MIDI button at the top right of the Live screen:

You will then see many of the Live controls become highlighted - as our screen shot shows highlighted in blue here (your Live settings or version might use a different highlight color). These highlighted controls indicate that they are “map-able” (able to be controlled remotely). 

---

6•6
To map one of the Live highlighted controls, simply click on it - Live then waits to receive a MIDI command. For this step, we’re going to map the Live Transport Play, Stop and Record buttons to the FBV A, B & C footswitches, respectively.

At the top of the Live software screen, click on the Live Transport Play button

You’ll see text at the bottom of Live’s screen indicating it is waiting to receive a MIDI Controller message

Stomp on your FBV “A” footswitch. Then you’ll see the text indicate the message was received, and the Play button is now mapped. Keep “Absolute” as the Mode

You’ll also see that the Play button now has a “1/1” overlaid on top. This indicates it is mapped to MIDI Channel 1, MIDI CC #1, which is of course what we configured the FBV “A” switch to send

While still in MIDI Map Mode, repeat these steps again for the Transport Stop and Record buttons, mapping the FBV “B” and “C” buttons to them. Once done, you should see the Transport buttons show the proper mapped indicators, like this:
If you have the Live MIDI Mappings panel open, you'll also see these mappings you just created there. Note that if you want to delete any of them, select the mapping in this list and hit the Delete button on your computer keyboard.

- Press the MIDI Map Mode button again at the top right of the Live screen to exit Map Mode. Now press your FBV’s A, B and C buttons to try them out. You should see Live’s Transport react accordingly! Repeat the above steps again if you like, and map the FBV “D” button to any other of Live’s “switch” type controls.

Note: The Ableton Live Transport design incorporates separate Play and Stop buttons, which each respond to a MIDI CC “Single” Switch Mode. Some application’s Transports incorporate a single, dual-function Play/Stop button. To alternately trigger the two functions for this type of switch, you can set the FBV Control MIDI CC Switch Mode to “Toggle” in the FBV Control application. Alternatively, some applications respond to MMC or Mackie type commands rather than MIDI CC commands for their Transport functions - Please check your software’s documentation for details.

It is worth noting here that there is nothing preventing you from mapping any one FBV Control to more than one parameter in your targeted MIDI/DAW software, and the result will typically be that FBV will control all mapped parameters simultaneously - which may or may not be the behavior you are after! One such useful implementation is to map one FBV footswitch to both the Live Transport Play and Record buttons, which then provides you a handy “one-touch” record switch since it toggles them both on simultaneously.

Mapping the FBV Pedal Controls to Live’s Parameters

Next, we’ll map the FBV’s Pedal Controls. The FBV “Pedal Wah” and “Pedal Volume” Controls each send a stream of MIDI CC values, so you can map to any available Live parameter that has a range, such as an effect knob or slider, to control it in real-time. We’ll first map the FBV Pedal Wah Control to Live’s Chorus effect - Dry/Wet parameter. This will allow us to change the Dry/Wet mix of Live’s Chorus effect in real-time. Note that this also makes it possible to “write” parameter automation in real-time using the FBV Pedal (more on that later).

- On your FBV device, make sure the onboard Pedal is set to “Wah” (the Wah LED indicator is on). If it isn’t, press the Pedal all the way forward and click the toe switch.
- In Ableton Live, first record or load an audio file in an audio track so that you have something to play and hear your effect in action.
- Load the Chorus as an insert effect on this audio track - You can do this by selecting Effects>Chorus>Chorus in the Live Devices panel and then drag this Chorus effect on top of your audio track to insert it.
• You'll then see the Chorus effect module appear in Live's lower effects panel. Now place Live into MIDI Map Mode (see the instructions above, at the start of this section). Once in Map Mode, you will see the Chorus effect's “map-able” parameters highlighted.

• We're going to map to the Chorus **Dry/Wet** knob. Just click on the knob and Live will then wait to receive a MIDI Control command. Move your FBV Pedal until you see the text at the bottom of Live’s screen indicate that the Dry/Wet parameter was successfully mapped:

  - Click on the Dry/Wet knob.
  - The text at the bottom field of Live indicates it is waiting for you to press a Control on your FBV device to map it.
  - The newly mapped MIDI Channel/CC is now displayed.
  - The text shows mapping details.

• Since we configured the FBV Pedal Wah control to send MIDI CC 5, you should see that Live’s Chorus Mix knob is mapped to Channel 1, CC 5.
Exit Live’s MIDI Map Mode and give it a try - You should see the Chorus Dry/Wet knob respond to your FBV Pedal movement! Now it’s your turn. Switch your FBV pedal so the “VOL” LED indicates it is set for the Pedal Volume Control and go ahead and map it to a different effect parameter following the same steps we just did here. You’ll see that you can switch between using the two mappings you just made for the Pedal Wah versus Pedal Volume Controls by toggling the pedal’s toe switch.

FBV Shortboard MkII Users: If you have an optional Expression Pedal connected, you can follow the above steps to additionally map it to another parameter as well!

**Mapping to an AU or VST® Effect Parameter**

As with most other DAW software, with Ableton Live you are not just limited to mapping your FBV footswitch and pedal controls to Live’s parameters. Once a 3rd party AU or VST Plug-In is loaded in the software, it is also possible to map to the Plug-In's parameters. In this example we’ll show you how to map the FBV Pedal Wah Control to the Line 6 POD Farm Plug-In's Wah Position parameter. This allows you work the FBV pedal and control the POD Farm Wah effect in real-time! These steps would be similar for the Line 6 POD GearBox Plug-In, or most any 3rd party AU or VST Plug-In effect you might have available.

- Switch your FBV on-board pedal so that the “WAH” LED is lit, indicating you are using the Pedal Wah Control.
- In Ableton Live, record or load an audio file in an audio track. A recorded clean rhythm guitar would work nicely here. We’re working in Live’s “Arrangement View” here.

![Audio Track in Live](image)

- In Live’s Plug-In Devices Browser panel, select your Plug-In and drag it on top of your audio track.

![Plug-In Browser](image)

- You’ll see the effect module load into Live's lower panel. If you click on the little arrow at the top of this effect module, you’ll see it expands to expose a **Configure** option. This allows you to add parameters from the Plug-In's edit window so that it is accessible within the effect module display.
Click the arrow here to expand the effect module...

Click the Configure button to add a POD Farm Plug-In parameter to this module

Now, in the POD Farm Plug-In window, click directly on the Wah edit panel’s Position knob to select this parameter.

Once you’ve selected the Plug-In parameter, you’ll see a slider appear in the Line effects module for that parameter.

Now just follow the same steps as in the previous examples to enter Live’s MIDI Map Mode, click on the parameter in the effect module, and then move your FBV Pedal to map it. For our example, we now have successfully mapped Channel 1, MIDI CC 5 from our FBV Pedal to the Wah Position parameter. Exit MIDI Map Mode.

Go ahead and hit Play in Live and work the FBV pedal and you’ll hear the mapped effect parameter do its thing. You might also see the control for the selected parameter within the effect’s own window move in response as well. In our case, the POD Farm Plug-In Wah Position knob moves in response. But wait - it gets better! Read on for more fun with mapped parameters!
Control Automation Recording with your FBV Pedal

Once you have a parameter mapped to your FBV pedal, in many cases the DAW software will also allow you to “record” your pedal moves in real-time as an automation envelope on your track. The perfect example for this is for us to use the POD Farm Plug-In Wah mapping we just created in Ableton Live, and record our FBV Wah pedal moves to add some snarky wah action on our guitar track. Other DAW applications differ in the exact way they offer track and effects automation, so be sure to check your DAW software’s documentation. But this example should give you the basic idea. With the FBV Pedal successfully mapped to the POD Farm Plug-In Wah (or the Plug-In parameter of your choice) try the following steps:

1) In Live's Arrangement View, you’ll want to make sure your audio track is not armed for recording (since we only want to record automation on this track, not audio). You should also see the POD Farm - Wah parameter shown here on the track. Note that right now when you move your FBV Pedal, an existing, flat envelope line across the track moves up and down in response.

   - Keep this track Record Arm button “off” for these steps

   - Once we mapped the POD Farm Wah-Position parameter in the previous steps, our Live audio track shows this parameter in its automation selector, and shows an (unedited) envelope across the track. If you move your FBV pedal, you’ll see this envelope line respond.

2) Rewind to the start of the track, click Live’s main Transport Record and then Play button. Once Live starts rolling, just start working the FBV pedal as desired to “record” the Wah pedal automation to your track. You’ll see envelope “edit points” added, capturing your pedal moves as you go.

   - Stop Live and then play the track back and you’ll hear that your Wah pedal performance was captured in real-time. Not happy with that take? Just undo, or zoom in and use your mouse to manually adjust the edit points to fine-tune the wah performance.
Apple GarageBand® - FBV MkII Setup Tutorial

Apple GarageBand uses its own proprietary protocol for controlling most of its software parameters, therefore, the FBV MkII MIDI controllers unfortunately cannot access all GarageBand functions directly. However, there are a few Pedal assignments that will allow you to control the current GarageBand track's Volume and Pan parameters. Additionally, there are some 3rd party software utilities you can install on your Mac® that will allow you to utilize FBV’ footswitch buttons to control GarageBand's transport functions.

To configure FBV's Pedals, launch the Line 6 FBV Control application and load the “FBV-Default. fbcv” preset.

- Set the Pedal Wah controller’s Value to CC 010.
- Keep the Pedal Vol controller settings as is (MIDI CC 007).
- Note that the pedals are also set to transmit to the FBV USB MIDI Out port 1. Your settings should appear like this:

```
<table>
<thead>
<tr>
<th>Pedal</th>
<th>MIDI CC</th>
<th>Value</th>
<th>Type</th>
<th>Preset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pedal Wah</td>
<td>CC 010 - Pan</td>
<td>010</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Pedal Vol</td>
<td>CC 007 - Channel Volume</td>
<td>007</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>
```

Now simply open GarageBand and load one of your Songs. When you move your FBV Pedal you should see that the Pedal, when set to “Volume” adjusts the selected track's Volume level, and when the Pedal is set to Wah, it will control the track's Pan setting. If you have a Shortboard and an optional Expression pedal connected, you can alternatively set Pedal 2 to MIDI CC Value 010 and then dedicate your Pedal Volume to control the track volume, and Pedal 2 to control the track Pan.

In order to control the Transport functions in GarageBand with the FBV you will need to have version 2.0.1 of Garageband or later. You'll also need to use the Line 6 FBV Control application to set whatever FBV footswitches you want to control the GarageBand transport to send MIDI CC values, and likely their Switch Type settings to “Momentary”. As noted above, the Garageband software does not offer control of transport or most other functions natively, so you will need to download add-on software that permits MIDI messages to control the parameters within GarageBand.

GarageRemote is one such 3rd party software and is available here: [http://www.muratnkonar.com/otherstuff/garageremote/](http://www.muratnkonar.com/otherstuff/garageremote/)

Once GarageRemote is installed and set up, start GarageRemote’s ‘Listener’ (it is off by default) so that it can relay MIDI notifications to GarageBand. GarageBand responds to MIDI CC’s 007 and 010 for current track volume and pan. You can use the Line 6 FBV Control application to create these MIDI CC settings, and save this as an FBV Preset so you can load the settings to your FBV at any time.
Apple Logic® - FBV MkII Setup Tutorial

Line 6 FBV MkII devices’ Footswitch and Pedal controllers can be configured to trigger Logic Transport functions, mixer faders, software instrument & plug-in parameters and more! To follow are the instructions for configuring an FBV MkII to function with Logic Pro 8 (the steps should be similar for other recent versions of Logic as well).

Line 6 FBV Control Application Settings

First, launch the Line 6 FBV Control Application and load the FBV-Default.fbv preset.

- Above shows the FBV-Default preset settings for an FBV Shortboard MkII. For an FBV Express MkII you’ll see only the A, B, C, D footswitch and Pedal rows. This preset assigns MIDI commands to all the device's MIDI Controllers for us so that we can then map them in Logic.
- Note that some Footswitch controllers (B, C, D and others) are set to transmit MMC (MIDI Machine Control) commands. These can be mapped to specifically control the Logic transport. You can alternatively set other Footswitch controllers to send the desired MMC messages to have them each control a Logic Transport function if you prefer.
- If you make any changes to the settings in FBV Control application, it is a good idea to go to File > Save As and this as a new preset - perhaps titled something clever, such as “Logic.fbv”.

Mapping Controllers with the Logic MIDI Learn Function

Logic Pro includes support for several MIDI “Control Surface” devices, which are typically large hardware units including faders, knobs, and other controls to emulate a large analog mixing console. The Line 6 FBV MkII units are not included as Logic-supported Control Surface devices, however, you can still easily map any of your FBV controllers to Logic or Plug-In parameters by using the Logic MIDI Learn feature! To follow we’ll show you how to map your FBV Pedal to control the Wah Position parameter of an inserted POD Farm AU Plug-In. These same steps can be followed to map any other pedal or footswitch controller on your FBV MkII device to any Logic parameter as well. It is recommended that you read through the Logic Control Surface Support documentation as well to learn more about the Logic MIDI Learn and controller capabilities.

First, here’s a handy tip in Logic: The Logic Pro transport always shows you when MIDI data is being received, and specifically the MIDI Channel, command type and value. For example, watch
the transport indicator and activate the pedal or footswitch on your FBV, and you'll see this MIDI In information displayed. In this screenshot, we just moved our Wah Pedal all the way forward, so we see the MIDI In show us that Logic last received on MIDI Channel 1, CC 11 with a Value of 127:

This indicator can be very helpful to confirm Logic is receiving MIDI from your device, and specifically it's MIDI command & values without always having to go back to the Line 6 FBV Control application dialog!

For this example, we'll map the Pedal of FBV to the POD Farm Plug-In's Wah Position parameter. If you do not happen to have the POD Farm Plug-In, you can insert any Logic or Audio Units effects Plug-In and perform the same steps:

- Make sure your FBV pedal is set to “Pedal Wah” (the Wah LED indicator on your FBV unit should be lit).
- Create an Audio track in your Logic session, and record or insert an audio file so you’ll have something to hear your Plug-In effect applied to. A nice clean guitar recording would work nicely here.
- Click on an Effects Insert slot for this Logic Audio track and insert the POD Farm Plug-In.
- In the POD Farm Plug-In window, load a Tone preset, and add one of the Wah models to your tone. Click on the Wah within the Signal Flow View to display Wah effect’s edit settings in the edit panel.

- Now click directly on the POD Farm Wah Position knob in the edit panel with your mouse and move it a bit - this allows the Wah Position parameter to be “selected”.
- Next, (before you click on anything else) go to the Logic > Preferences > Control Surfaces menu, and you want to select Learn Assignment for “Wah - Position”.

- As you can see by the name of the “Learn Assignment...” menu command, Logic automatically detected the POD Farm Plug-In “Wah - Position” parameter since it was the last item you selected with your mouse in the previous step.
• When you select this “Learn Assignment...” menu command, it launches the Logic Controller Assignments dialog, and a message informs you that it is waiting for you to access your MIDI Controller so that it can “Learn” the MIDI command from it.

Note that the Controller Assignment dialog also offers an “Expert View” - this offers many more options and allows you to further manually map MIDI controllers. Please see the Logic documentation for this dialog if you want to explore this further! The Easy View works great for instantly mapping a controller.

• Now move your FBV Pedal, and you should see the Controller Assignment dialog receive and “Learn” the MIDI Control message (which is configured to transmit MIDI CC 11, with a Value range of 0 - 127, as part of the FBV-Default preset we previously selected in the Line 6 FBV Control application).

You'll see the “Learned” MIDI Control command listed here.

• Exit the Controller Assignments dialog and give the FBV Pedal a try. You should see the Position knob within the GearBox Plug-In window move in response. Press Play in Logic to hear your audio track play, and when you move the pedal, you should hear the Wah effect do its thing on your track!

• Note that you can also set your Logic Audio track to record automation for this POD Farm Plug-In, Wah Position parameter, and you can use the pedal to record a Wah “performance” too.

You should be able to repeat the above steps to access any mappable parameter in Logic with any of your FBV Controllers - Mixer faders, Pan knobs, solo switch, Software Instrument knobs, other Plug-In parameters, etc.

Controlling the Logic Transport Functions

To set your FBV footswitches to control the Logic transport controls, you need to set Logic to “listen” for the MMC commands that your FBV footswitches are now configured to transmit:

TIP: Alternatively, you can use the Command+L key shortcut instead of going to the Logic Preferences menu.
- Launch Logic and go to Preferences > MIDI.
- Select the Sync tab.
- Click the MIDI Sync Project Settings… button at the bottom right of the Sync tab - this launches the Song Settings dialog.
- In the section labeled MIDI Machine Control (MMC), check the Listen to MMC Input option.

Note that this is a per-Song option in Logic. To make this option “global”, you must modify your Logic template file with this MMC setting.
Cakewalk SONAR™ - FBV MkII Setup Tutorial

Line 6 FBV MkII devices’ Footswitch and Pedal controllers can be configured to trigger many of Cakewalk SONAR functions, software instrument & plug-in parameters and more by taking advantage of the SONAR built-in ACT (Active Controller Technology) features! To follow are the instructions for configuring an FBV MkII to function with SONAR 8 Producer (the steps should be similar for other recent versions of SONAR as well).

Line 6 FBV Control Application Settings

First, before launching SONAR, connect your FBV to your computer's USB port, launch the Line 6 FBV Control Application and load the FBV-Default.fbv preset.

<table>
<thead>
<tr>
<th>Control</th>
<th>MIDI Command</th>
<th>Value</th>
<th>Port</th>
<th>Channel</th>
<th>Switch Mode</th>
<th>CC</th>
<th>Val</th>
<th>CC</th>
<th>Val</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function 1</td>
<td>MMC</td>
<td>Record Punch</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function 2</td>
<td>MMC</td>
<td>Pause</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank Up</td>
<td>Program Change</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Increment</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank Down</td>
<td>Program Change</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Decrement</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>MIDI CC</td>
<td>064 - Sustain Pedal On/Off</td>
<td>1</td>
<td>1</td>
<td>Momentary</td>
<td>64</td>
<td>127</td>
<td>64</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>MMC</td>
<td>Play</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>MMC</td>
<td>Stop</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>MMC</td>
<td>Rewind</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tap</td>
<td>MMC</td>
<td>Fast Forward</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stomp</td>
<td>MIDI CC</td>
<td>065 - Portamento On/Off</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>65</td>
<td>127</td>
<td>65</td>
<td>0</td>
</tr>
<tr>
<td>Modulation</td>
<td>MIDI CC</td>
<td>127 - Poly Mode On</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>127</td>
<td>127</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Delay</td>
<td>MIDI CC</td>
<td>126 - Mono Mode On</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>126</td>
<td>127</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Reverb</td>
<td>MIDI CC</td>
<td>127 - All Notes Off</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>127</td>
<td>127</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Toe Switch</td>
<td>MIDI CC</td>
<td>102 - CC 102</td>
<td>1</td>
<td>1</td>
<td>Toggle</td>
<td>102</td>
<td>127</td>
<td>102</td>
<td>0</td>
</tr>
<tr>
<td>Pedal Wah</td>
<td>MIDI CC</td>
<td>011 - Expression</td>
<td>1</td>
<td>1</td>
<td>Pedal</td>
<td>11</td>
<td>127</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pedal Vol</td>
<td>MIDI CC</td>
<td>007 - Channel Volume</td>
<td>1</td>
<td>1</td>
<td>Pedal</td>
<td>7</td>
<td>127</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pedal 2</td>
<td>MIDI CC</td>
<td>011 - Expression</td>
<td>1</td>
<td>1</td>
<td>Pedal</td>
<td>11</td>
<td>127</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

- Above shows the FBV-Default preset settings for an FBV Shortboard MkII. For an FBV Express MkII, you'll see only the A, B, C, D footswitch and Pedal rows. This preset assigns MIDI commands to all the device's MIDI Controllers for us so that we can then map them in SONAR.

- You likely do not need to make any changes to these default settings, but if you do make any changes, it is a good idea to go to File > Save As and this as a new preset - perhaps titled something clever, such as “SONAR.fbv”.

- Exit the FBV Control application.

Configure SONAR MIDI Device Settings

To set SONAR so that it can receive surface controller MIDI data from your FBV MkII, you'll need to select your device in the SONAR MIDI Device Settings dialog. Be sure to always have your FBV device connected to your USB port before launching SONAR. Launch SONAR and go to the SONAR Options/MIDI Devices and check the first FBV MIDI Out Port as the MIDI Input device and choose OK.
Use FBV MkII as a Surface Controller in SONAR

SONAR includes its own ACT MIDI Controller Plug-In feature, which allows you to easily create, customize and save mappings for any MIDI surface controller. The SONAR ACT feature is very powerful and it is recommended that you read the SONAR documentation. We'll show you how to create your own mappings for FBV's Footswitch or Pedal controllers. Open or create a new project in SONAR, and then follow these steps:

- Go to the SONAR Options > Controllers/Surfaces.

- In the Controllers/Surfaces dialog, click the “Add new Controller/Surface” button. For Controllers/Surfaces, choose “ACT MIDI Controller”, and for Input Port choose your first FBV MIDI Out port. You can set the Output Port option to “None”, then click “OK”. Your settings should now look like this:

- Close the Controllers/Surfaces dialog when done.

- Next, go to Views > Toolbars and ensure the Controllers/Surfaces box is selected, then close the window. You'll see this adds some handy ACT options to your SONAR Toolbar.
In the ACT Controllers toolbar options, click the Controllers/Surfaces Properties button that is at the right end of the Control Surfaces toolbar.

In the ACT MIDI Controller dialog, select the Default preset from the Presets menu. When this preset is loaded, you'll see that the “cells” in the dialog allow access to numerous SONAR parameters. Also, when you click on a Plug-In or Software Instrument edit window to shift the “focus” to it, the parameters for that plug-in/instrument become available in the ACT dialog cells. However, your FBV Controllers are not yet mapped to control any of these parameters with the Default preset. To configure a mapping, you can use the MIDI Learn function.

The ACT MIDI Control dialog - Default preset selected (the SONAR main window has “focus”)

Using the SONAR ACT MIDI Learn Function

Here is an example of how to map the FBV Pedal Wah controller to the Wah Position parameter of the Line 6 GearBox Plug-In, allowing you to remotely control the GearBox Wah in real-time as you hear the input monitor recording signal or playback of your audio track. These mapping steps are the same to map any knob, button, footswitch controller to any other available parameter in the ACT MIDI Controller dialog as well.

- Open the SONAR ACT MIDI Controller dialog with the Default preset loaded, as described above. Leave this dialog open and where you can see it.
- Create an audio track in your SONAR project, and record or insert an audio file so you'll have something to hear your Plug-In effect applied to. A nice clean guitar recording would work nicely here.
- Click on an FX Bin Insert slot for this audio track and insert the GearBox Plug-In.
- In the GearBox Plug-In window, load a Tone preset, and click on the Wah pedal effect to make sure it is “on” and to show the Wah effect's edit settings in the edit panel.
With your “focus” still on the GearBox Plug-In window, you should now see the many GearBox Plug-In parameters shown in the cells of the ACT dialog. We specifically want to access the Wah - Position parameter. To see this you’ll need to select Bank 4 of the top row of “Rotary” cells, and the Wah - Position parameter should appear in the Rotary 1 controller slot.

The Default preset is selected.

In the Controllers tab, select Bank 4 for the top row of cells.

The GearBox Plug-In Wah-Position parameter appears in the Rotary 1 slot.

Click on the lower cell of the Rotary 1 controller slot and this places it in “MIDI Learn” mode, where it then waits to receive a MIDI command from the assigned MIDI surface control device (your FBV).

Now move your FBV Wah Pedal and you should immediately see the Rotary 1 cells switch out of MIDI Learn mode, meaning your Pedal’s MIDI command was “learned”, thus mapping your controller to the parameter.

Now just move your pedal and you should see the big Wah position knob move in response in the GearBox Plug-In window. Play your track and you’ll hear the Wah do its thing.

Repeat the above steps to use MIDI Learn to map any other controllers from your FBV MkII device to other SONAR, plug-in, or instrument parameters. When done, type a new title in the Preset field at the top of the ACT dialog and click the Save button to save all these new mapped settings as a SONAR ACT preset.

The SONAR ACT feature offers a great deal more functionality for MIDI control - please be sure to read the SONAR Help documentation for details!
Propellerhead Reason® - FBV MkII Setup Tutorial

The FBV MkII devices of course do not include the note keys & knobs like a Line 6 KB37 “keyboard” controller offers, to allow you to play the Reason instrument devices, record MIDI performances, etc. However, FBV MkII devices do offer Footswitch & Expression Pedal controllers, which can be used to trigger and control lots of parameters in Reason! To configure an FBV for this functionality, you’ll need to set it up in Reason as a “Generic MIDI Control Surface” (although, for the record, we hate to think of our beloved FBV “generic”!) Just follow these steps - which are the same in Windows® or Mac® OS X, unless otherwise noted.

- In the Reason Preferences dialog, select Keyboards and Control Surfaces and click the Add button, then select <Other> in the list of devices.

- Make the following settings in the Control Surface dialog:
  
  ![Control Surface Dialog]

  Select MIDI Control Surface as the Model.

  Type in a name for your device (this is how it will appear in the Reason MIDI Controller menus).

  Choose the USB MIDI Port that you want Reason to receive from. We’ll choose the first FBV MIDI Out Port (note that your port names appear differently on Mac® or Windows® - see page 6.1).

  Click OK when done.
• You should now see your FBV device configured accordingly. Exit the Preferences if all settings appear as shown here:

![Preferences](image)

Please see the next section for how to map your FBV MIDI controllers to Reason parameters.

**Configuring FBV MIDI Controllers with Remote Override**

Reason also offers its “Remote Override” feature, which is an easy way to allow Reason to “learn” the MIDI message coming from your MIDI control device and instantly map it to a Reason parameter. You can use the Remote Override options for your FBV MkII when configured as a Generic MIDI Control device, as described in the previous section.

First we’ll need to make sure your FBV footswitch and pedal controllers are configured to send MIDI CC messages out the MIDI Port we selected in the Generic MIDI Control setup steps. With the Reason application closed, launch the Line 6 FBV Control application and load the “FBV-Default.fbv” preset.

![MIDI CC Messages](image)

• When the FBV-Default preset is loaded, you can see the FBV Pedal Vol controller is already set to transmit MIDI CC 007. Note that the Pedal Vol is set to transmit its command to the FBV MIDI Out port 1, which is what we want since this is the port we selected in the Reason Generic Controller setup steps for Reason to receive MIDI. Exit the FBV Control application. We’ll next show how to map this Pedal to a Reason parameter.

• Make sure your FBV pedal is set to utilize the Pedal Vol controller (the “Volume” LED indicator on your FBV unit should be lit).
• Launch Reason and load one of your Reason projects. Right click (Windows®) or Ctrl+click (Mac®) on any Reason component’s knob or slider that you want to control with your Pedal. We’ll choose the FREQ knob of one of the Reason synth devices.

Right click (Windows®) or Ctrl+click (Mac®) directly on the knob you want to control...

Then choose **Edit Remote Override Mapping**.

• In the dialog, just check the box for “Learn From Control Service” and Reason will wait to receive a MIDI CC message from your assigned MIDI Control Surface.

Move your FBV Pedal and you should see the Control Surface Active indicator receive a MIDI signal.

Once it does, the Control Surface and Control fields above will fill in automatically with the “learned” MIDI device name and CC value, as shown here.

Click **OK** once the step is complete.

• And that does it! Now if you move your Pedal, you should see the selected knob move in response. You can follow these same steps to map any FBV controller directly to any assignable Reason knob, slider, switch, etc.

The Reason Remote Override feature offers several other features - it is recommended you check the Reason Help documentation covering all that this powerful feature offers for your Line 6 MIDI Controllers!
Digidesign Pro Tools® LE Transport Control - FBV MkII Setup Tutorial

We’ve provided a step-by-step tutorial here for how to configure an FBV Shortboard or Express MkII device to remotely control the Transport of the Digidesign Pro Tools LE® 8 software. (The steps are similar for other Pro Tools versions as well.) Configuring a MIDI Controller device such as FBV MkII for this task in Pro Tools is not too obvious, but pretty simple once you know the steps, and it can be very helpful to have foot control over your Transport functions for recording and punch-ins!

Note: For the following steps, we’re running a Mac®, but the steps are the same if you are using Windows® XP or Vista®, unless otherwise noted.

FBV Control Assignment Configuration

The first step, before even launching Pro Tools, is that we’ll need to configure a set of MIDI assignments for the footswitches and pedals of our FBV device. Pro Tools utilizes MIDI Machine Control (MMC) commands to access its Transport functions remotely. Therefore, we’re going to assign MMC commands to our FBV footswitch controls using the Line 6 FBV Control application, and save this as an FBV preset.

- Connect your FBV MkII device to your computer and launch Line 6 FBV Control.
- Go to File > Open and load the “Blank.fbv” preset.
- Go to File > Save As and let’s title this new preset “PT-Transport.fbv”.

For this example, we’ll configure several FBV Controls as follows (you can do the same on either an FBV Shortboard or Express MkII device):

- Assign the A, B, C & D footswitch Controls’ MIDI Command settings all to “MMC”.
- Set the A Control’s Value setting to “Play”.
- Set the B Control’s Value setting to “Stop”.
- Set the C Control’s Value setting to “Record Punch (Pro Tools)”.
- Set the D Control’s Value setting to “Rewind”. Note that for Rewind, you have the option of choosing a Switch Mode, each of which offers a different behavior:
  - “Single” initiates rewind action on each footswitch press, and keeps rewinding.
  - “Momentary” initiates rewind action on the footswitch press, but stops rewinding when you release the footswitch.
  - “Toggle” alternates between initiating rewind and stopping rewind on each successive footswitch press.
- Optionally, you can assign the “Fast Forward” Value to one of your footswitches instead of one of the above (or for an additional footswitch if you have a Shortboard. However, note that the MMC “Pause” value simply performs the same action as “Stop” (since Pro Tools’ Transport has no Pause button).
- Set the Port and Channel for all of the above Controls to “1”, since we want to transmit all our MIDI commands to the FBV USB MIDI Out Port 1, Channel 1.
- For all other FBV Controls, we’ll keep them to Unassigned since we won’t be using them for this example.
The result should appear in the Control Properties list like this:

<table>
<thead>
<tr>
<th>Control</th>
<th>MIDI Command</th>
<th>Value</th>
<th>Port</th>
<th>Channel</th>
<th>Switch Mode</th>
<th>CC</th>
<th>Val</th>
<th>CC</th>
<th>Val</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function 1</td>
<td>Unassigned</td>
<td>-</td>
<td>1</td>
<td>1</td>
<td>-</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Function 2</td>
<td>Unassigned</td>
<td>-</td>
<td>1</td>
<td>1</td>
<td>-</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Bank Up</td>
<td>Unassigned</td>
<td>-</td>
<td>1</td>
<td>1</td>
<td>-</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Bank Down</td>
<td>Unassigned</td>
<td>-</td>
<td>1</td>
<td>1</td>
<td>-</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>A</td>
<td>MMC</td>
<td>Play</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>MMC</td>
<td>Stop</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>C</td>
<td>MMC</td>
<td>Record Punch(Pro Tools)</td>
<td>1</td>
<td>1</td>
<td>Single</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>D</td>
<td>MMC</td>
<td>Rewind</td>
<td>1</td>
<td>1</td>
<td>Momentary</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

- When settings are complete, exit the Line 6 FBV Control application and leave your FBV connected to your computer.

**Configure Pro Tools LE for FBV MkII device**

The next step is to make a few settings within Pro Tools to allow it to receive the MMC commands from your FBV MkII device. Launch Pro Tools and open or create a new session, then make the following settings:

- Go to the Setup menu and select Peripherals.
- In the Peripherals dialog, choose the Machine Control screen and make the following settings:

  - For MIDI Machine Control (Master) - check the Enable box, click on the menu to the right and from the “Predefined” sub-menu, choose your connected FBV MkII device, and set the ID to 125. Keep the Preroll set to 90 frames.
  - For MIDI Machine Control (Slave) - check the Enable box, and keep the ID set to 126.
  - Exit the Peripherals dialog.
Next, we need to access the small “Pro Tools” menu on the Transport.

In the Pro Tools - Transport sub-menu, select “Pro Tools” so that it is checked.

Now, in the Pro Tools - Online sub-menu, select “MMC” so that it is checked.

...And that is it! Now just try pressing your FBV’s A, B, C & D buttons and you should see it control the Pro Tools transport accordingly.
Steinberg Cubase® - FBV MkII Setup Tutorial

Line 6 FBV MkII devices can be configured to control numerous Cubase parameters, including transport functions, mixer parameters and more! To follow are the instructions for configuring FBV MkII to function with Steinberg Cubase® 4 on Windows®, however, the steps should be similar for other recent Cubase® and Nuendo® versions on both Windows® and Mac® as well.

Line 6 FBV Control Application Settings

First, before launching Cubase, connect your FBV to your computer’s USB port, launch the Line 6 FBV Control Application and load the FBV-Default.fbv preset.

- Above shows the FBV-Default preset settings for an FBV Shortboard MkII. For an FBV Express MkII you’ll see only the A, B, C, D footswitch and Pedal rows. This preset assigns MIDI commands to all the device’s MIDI Controllers for us so that we can then map them in Cubase.
- The above steps assign MIDI commands to all the device’s MIDI Controllers for us so that we can then map them in Cubase. The steps configure some of the FBV footswitches to transmit MMC (MIDI Machine Control) commands to control Cubase transport, and MIDI CC messages to trigger other Cubase functions.
- You likely do not need to make any changes to these default settings, but if you do make any changes, it is a good idea to go to File > Save As and this as a new preset - perhaps titled something clever, such as “Cubase.fbv”.
- Exit the FBV Control application.

Cubase MIDI Port Setup

Since you are using your FBV MkII device as a MIDI controller device, you’ll want to exclude it from the Cubase “All Inputs” MIDI Port settings. This way, if you choose the “All Input” option for one of your MIDI tracks, the track will not receive input from your FBV device and record its MIDI controller data into the track. To configure this setting, go to the Cubase Devices > Device Setup dialog. Since the settings we used in the Line 6 FBV Control application configured all FBV controllers to transmit to the FBV USB MIDI Out port 1, we can select just this first FBV MIDI port in Cubase, and de-select FBV MIDI ports 2, 3 & 4.
Select MIDI Port Setup

Uncheck the “All Inputs” box for all the FBV USB MIDI Ports

Check the first FBV USB MIDI port, and uncheck the FBV ports 2, 3, & 4

Note that since we’re using Windows® XP in this example, the FBV MIDI ports appears as “USB Audio Device”. They will appear named differently if using Windows® 7, Vista® or Mac OS® X (see page 6•1).

Cubase Parameter Control

Cubase offers support for many 3rd party MIDI Control Surface devices - large hardware units designed to emulate analog mixing consoles with dozens of hardware faders, knobs and buttons. Your Line 6 FBV MkII device is not one of these “Steinberg-supported” Control Surface devices, however, it is still possible to map any of your FBV MIDI controllers to the many Cubase parameters. This is accomplished by configuring your FBV MkII device as a “Generic Remote” device. To accomplish this, go to the Cubase Devices > Device Setup dialog once again:

- If you do not already see the “Generic Remote” under the Remote Devices in the left panel, click on the “+” button at the top left of the dialog and choose Generic Remote from the menu to add it.

Select Generic Remote

Select the first FBV USB MIDI port as the MIDI Input
In the top right panel you will now see a list of Cubase parameters that you can map your FBV device's controllers to. The easiest way to do this mapping is to use the **Learn** function. For example, to map the “Fader 1” parameter at the top of the list to your FBV's Pedal Vol, follow these steps:

- Make sure your FBV pedal is set to Pedal Vol (the “Volume” LED indicator on your FBV is lit).
- In the Cubase Device Setup dialog, click directly on the “Fader 1” Control Name in the top right panel.
- Move your FBV pedal.
- Press the **Learn** button at the right of the dialog.
- You should see the MIDI Channel and other settings in the Fader 1 row change, indicating it has “Learned” the MIDI CC message that your FBV Pedal Vol controller is transmitting (which is MIDI CC 011, on MIDI Port 1, Channel 1, per the settings in the Line 6 FBV Control application).
- Now look at the Cubase Mixer window and watch the channel strip for track 1 – you should see its fader respond to the FBV pedal moves.
- Repeat the above steps to map other FBV controllers from your device to other Cubase parameters in the list.
- Note that you’ll need to use pedal controllers to map to the Cubase fader, knob and slider type parameters, and footswitch buttons to map to the Cubase switch type parameters.
- Also, these Cubase parameters typically need to receive MIDI CC type commands, so you'll want to make sure that your FBV footswitch or pedal controller is transmitting this type of MIDI message, using the Line 6 FBV Control application.

The lower right panel also allows you to map to more channel strip parameters, beyond track 1 - 16. It is also possible to customize these Generic Remote parameter lists using the other options in this dialog. Please see the Cubase Help documentation for details.

**Cubase Transport Control**

Cubase allows control of its transport by way of a simple **MIDI Machine Control Slave** option - meaning it will listen for MMC commands from a selected device and respond accordingly. Since we assigned MMC commands to several FBV footswitch buttons in the FBV Control application, all we need to do is set Cubase to listen to your FBV MkII device for the MMC commands.

Go to the Cubase **Transport** menu and select **Project Synchronization Setup**.
Check the box for MMC Slave Active

Choose your first FBV USB MIDI Port for the MIDI Input

Click OK to exit the dialog

Now try your FBV footswitches that you assigned to transmit MMC commands, and you should see the Cubase transport respond.

With the 3rd party application examples covered in this chapter you should now be pretty well informed on how to get your Line 6 FBV MkII device configured as a USB MIDI controller. Most other DAW applications that offer remote MIDI control can be configured similarly. Please see the following chapter for more helpful tips and Line 6 online resources!
We’ve included this handy Reference chapter in case the answer to your question wasn’t too clear in the previous chapters (or for you impatient types that want the quick answer!). Here we’ve included lots of questions & answers, troubleshooting tips, and other info we figure you might be too embarrassed to ask about. You really should read through the other chapters too though!

Questions & Answers

General Q&A

What is an “RJ45” cable? FBV MkII utilizes a cable with “RJ45” style connectors on each end to connect to Line 6 amps and POD® devices. We didn’t make up the name, that’s the industry term for the style connector. It is the same as used for computer Ethernet network cables - so, if you happen to need a replacement cable, just head to any electronics or computer store and just tell them you need a standard “Cat. 5” network cable, and they’ll think you know exactly what you’re talking about.

I heard I can use my FBV™ MkII with Line 6 Monkey™ to update my Spider® IV or Spider Valve™ MkII amp - how do I do that? You heard correctly! The short answer is to simply connect your amp to an FBV MkII via the RJ45 cable, and FBV MkII to your computer via USB, and then launch the Line 6 Monkey software. This will connect to the Line 6 Online server and recommend any necessary updates for your Spider amp. Note that is required that you register your FBV MkII to obtain some updates. For more info, please see the Spider IV or Spider Valve MkII Advanced User Guide found on the FBV MkII Online Help site.

What is the FBV “firmware” or “flash memory” and why do I need to update it? You can think of the firmware of your FBV MkII device as the permanent “software” on the inside of the device that makes things tick, and the flash memory is the section that holds instructions and device settings. It is recommended that you run Line 6 Monkey every so often and let it install any recommended flash memory update so that your device has the latest and greatest set of data to allow it to be compatible with other devices & software and function at its best.

Do I need a special USB cable for FBV? Nope. Any standard USB cable will do, just like you’d buy to connect any USB peripheral device to your computer. No need to spend extra on those 24 karat gold tipped, ultra-shielded, or quasi-impenetrable types (unless you want to).

Can I connect my FBV MkII to a USB hub? Yes, but it really should be a powered hub (one that has its own AC power cable powering the hub itself, rather than one powered fully by your computer). However, you’ll typically get the best USB communication when using one of the USB ports on your computer itself rather than a hub.

Where is the installer CD for my FBV MkII? There is no device driver installation software required for your FBV MkII device - just connect it to your Mac® or Windows® computer’s USB port (see “Getting Started” on page 1•1). All the other Line 6 software that works with your FBV can be downloaded from the line6.com/software site, or by running the Line 6 Monkey software.

USB/MIDI Q&A

I already installed my FBV, but when I plug into a different USB port, why is Windows® asking me to install it again? This is normal behavior on Windows® computers - it will need to install a USB device the first time it is installed into a different USB port (see “Getting Started” on page 1•1). Go ahead and run through the Windows® device installation if prompted. You should not be asked to install FBV again when plugging into the same USB port thereafter.
If FBV MkII is a MIDI device, why does it not have any 5-pin MIDI cable connectors on it? FBV MkII does all its MIDI communication via its USB connection to your computer. When you launch any MIDI or DAW software, you'll be able to select any of the four FBV USB MIDI Out ports to receive MIDI from it. No messy MIDI cables are needed!

Can I use FBV MkII to control POD Farm™ 1.x Plug-In or standalone application? Since POD Farm 1.x version does not support remote control via MIDI, it is not possible to directly control it with FBV. However, when using POD Farm Plug-In within a DAW host application, you typically can set FBV to control any Plug-In's parameters in real-time, and to record automation. Therefore, it is also possible to control POD Farm Plug-In's parameters this way as well - please see the “Ableton Live® - FBV MkII Setup Tutorial” on page 6•4 as well as the other setup tutorials and your MIDI/DAW software documentation. The newer POD Farm™ 2 version Plug-In and standalone application both fully support MIDI control via FBV MkII controllers (see “FBV™ MkII with Line 6 POD Farm™ 2” on page 4•1).

My MIDI/DAW software requires SysEx messages to control some functions - can I customize and send SysEx with FBV MkII? FBV MkII devices can be set to transmit MMC (MIDI Machine Control) messages, which is one type of SysEx message, however, the Line 6 FBV Control application does not provide extended capabilities to allow you to manually type in or import/export SysEx MIDI data.

Why doesn't my software see FBV MkII as an available MIDI device? The most typical cause of this is launching your MIDI/DAW software before connecting your FBV USB cable to your computer. Try exiting all software, be sure your FBV is connected and launch your software again. Also try connecting directly to one of your computer's on-board USB ports rather than a USB hub if you still experience problems.

How can I edit and save an FBV preset on my computer without also automatically overwriting the settings currently stored on my FBV device? When using the Line 6 FBV Control software, changes to any settings in the software are instantly sent to the connected FBV device, updating the current settings stored in FBV's internal memory. But you can simply disconnect the USB cable from your FBV and still use the Line 6 FBV Control application if you want to edit and save any FBV preset file. Then, whenever you like, just connect your FBV again and go to File > Open and select your saved .fbv preset file to load it onto your FBV device.

My friend has an FBV MkII too - can we share preset files? Sure! You can create, edit and save your own custom FBV presets using the free Line 6 FBV Control software, and then simply send the .fbv file to any other FBV MkII user to load. Note that the files are also compatible even if one of you has a Shortboard MkII and the other an Express MkII (the additional Controls of a Shortboard-created preset are simply ignored by an Express unit).

**Troubleshooting**

Running into problems? To follow are some things to check for FBV MkII device operation issues.

**Line 6 Amp/POD® Operation**

FBV won't power on when connected to my Line 6 amp/POD - FBV MkII devices receive power from the RJ-45 cable connection to your amp/POD. Therefore, the culprit is typically that your RJ-45 cable is not securely connected to both devices (push the cable into the device until you feel it “click”), or that your cable itself is bad. Note that your connected amp or POD must also be powered “on” for FBV to receive power!
FBV does not control anything on my Line 6 amp or POD - FBV MkII must be securely connected to your FBV and amp/POD using an RJ-45 cable (push the cable into the device until you feel it “click”). Other possible causes might be:

- Connect FBV before powering on your amp/POD - If you connected your FBV to your Line 6 amp or POD after the device was already on, you might try toggling the power off and then on again, with your FBV already connected, to make sure it is properly initialized.
- FBV is in “USB Mode” - Whenever a USB cable is connected to FBV, it places the device in “USB Mode”, which over-rides any communication with any RJ-45 connected amp/POD device. Remove the USB cable to exit USB mode.
- POD X3 Dual Tone behaviors - On POD X3, FBV will control the models for the currently selected Tone only (Tone 1 or Tone 2). Also, each POD X3 preset has its own Pedal assignment settings which determine Tone 1 & Tone 2 control.

Why does my FBV pedal sometimes control different functions on different POD X3 presets? Each POD X3 preset allows the pedal settings to be edited and saved independently. Go to the POD X3 System screen to configure these Pedal settings for the current preset.

Why does my Shortboard “Function 1” switch control different functions on different POD X3 presets? Each POD X3 preset allows the Shortboard's Function 1 footswitch function be edited and saved independently. Go to the POD X3 System screen to configure “LP SW” settings to set the behavior for the Function 1 button with the current preset.

USB/MIDI Operation

FBV won’t power on when connected to my computer. FBV MkII receives power from the USB cable, when connected to your computer. Make sure both ends of the USB cable is connected securely. It is typically best to connect directly to one of your computer's on-board USB ports (rather that to a USB hub). You might also try a different USB cable to make sure the cable itself is not the problem.

Line 6 Monkey won’t detect my FBV MkII device. Be sure your FBV is properly connected to your computer’s USB port and receiving power before launching Line 6 Monkey.

- Windows® users only: Be sure to exit the Line 6 FBV Control application or any MIDI/DAW software that might be using your FBV before launching Line 6 Monkey. The Windows® Class Compliant USB driver does not permit more than one application to utilize the same MIDI port at one time (and Monkey needs to use a few MIDI ports to do its thing).

The Line 6 FBV Control application won’t detect my FBV MkII device. First, look at the previous issue and make sure your FBV is properly connected and receiving power. Here are other possible solutions:

- Make sure you have the latest Flash Memory version - Connect your FBV to your computer and run Line 6 Monkey. It will check the Line 6 online server and inform you if there are newer Flash Memory or other updates available for your FBV. It is highly recommended that you install available Flash Memory and FBV Control application updates for proper product compatibility.
• **Windows® users** - The Windows® Class Compliant USB driver inherently will not allow more than one application utilize one USB MIDI port at a time. So, if you have the Line 6 FBV Control application running, and/or more than one MIDI/DAW application, you'll need to either exit all but one such application that uses your FBV device, or change some of your MIDI settings in these applications. See “Windows® MIDI Port Communication” on page 6•1.

• **Windows® 7 & Vista® Sleep mode** - It is not recommended that you exit Vista using the Sleep mode while you have the Line 6 FBV Control application running, or with your FBV connected to your USB port. Due to the behavior inherent behavior of Vista's USB Class Compliant driver, some USB devices (such as FBV) will not properly initialize when resuming from Sleep mode, resulting in applications failing to detect the device. You can resolve this issue by exiting the Line 6 FBV Control application, and then disconnecting and reconnecting your FBV USB cable.

**My MIDI/DAW software won't let me enable FBV USB MIDI Ports** - First, check that your FBV is properly connected and receiving power **before** launching your MIDI/DAW software. Windows® users should also refer to the previous issue regarding the Windows® USB Class Compliant driver behavior (you may need to disable the use of FBV MIDI ports on any other running software, or exit the FBV Control application). Please also check the documentation for your MIDI/DAW software. These applications vary greatly in the specific ways they need to select and enable MIDI controller devices.

**My MIDI/DAW software has the proper FBV USB MIDI Ports enabled, but the software is still not receiving the FBV MIDI commands** - First, check that your FBV is properly connected and receiving power **before** launching your MIDI/DAW software. There can be a number of settings required by your specific MIDI/DAW software to receive MIDI Control data from a device such as your FBV. Be sure to check your MIDI/DAW software's documentation and read through “FBV™ MkII with 3rd Party Software” on page 6•1 for helpful tips and setup examples. Some DAW software requires special settings for a “MIDI Control Surface” or “MIDI Controller”, which may be separate from MIDI settings to receive MIDI input on a MIDI track, for example. A few other things to check:

• Each footswitch and pedal control of your FBV can be transmitted to one of four MIDI ports (FBV MIDI Out ports 1 through 4). Further, each control can be set to transmit out any of 16 MIDI channels on the selected port. You can see (and change) these port and channel settings using the FBV Control application. You'll need to make sure your MIDI/DAW software is set to receive MIDI control data on the same port & channel to which your FBV is transmitting.

• Are you sure you have your FBV sending the proper types of MIDI commands? Some DAW applications utilize MIDI CC commands to access all their parameters. Some use MIDI Machine Control (MMC) or Mackie format commands to access transport buttons. Further, some MIDI/DAW applications have a “fixed” set of assigned MIDI commands for their set of accessible parameters. The only way to know for sure is to consult the software manufacturer's documentation. A quick search or post on the software manufacturer's user forums is usually a good way to find out where to look for his info.

**Online Resources**

Hungry for more info? We've got plenty of helpful resources just a click away.

• Several additional Help documents covering the latest FBV news and support info, product Release Notes and more are available here:

FBV Online Support
• For info on POD Farm 2 Plug-In & POD Farm 2 standalone application’s MIDI control functionality, please see the detailed User Guides from the official Line 6 POD Farm source:

POD Farm Online Help

• Got other Line 6 gear? You can find the latest versions of Line 6 product manuals available here for download:

Line 6 Product Manuals

• For technical support, choose from the many options listed on the Line 6 Support, including the searchable Knowledgebase:

Line 6 Support

• Can’t get enough of that Line 6 Gear, or want to check out the latest Add-Ons and accessories? Head on over to the Line 6 Store!

Line 6 Online Store

• Join the Community! Line 6 users are welcome the Line 6 Online Community, the place to get:
  • Free downloadable Tones for POD Farm.
  • Free MP3 Jam Tracks.
  • Free loops for GarageBand®, Acid®, Reason® and more.
  • Free guitar lessons from LA session pros.
  • Breaking news, links and video clips.
  • Info on contests and special offers.
  • Access to discussion forums, software updates and more.

Line 6 Community